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Welcome
Congratulations on your purchase of a Nicolet 4700 or Nicolet 6700
spectrometer from Thermo Electron! The spectrometer lets you
collect spectra in the mid-IR, far-IR and near-IR spectral ranges. The
system integrates advanced hardware features with the power and
flexibility of Thermo Electron’s OMNIC software*.

If you have not used the spectrometer before, view the
“Spectrometer Tour” and “Getting Started With OMNIC” tutorial
available through Getting Started in the Help menu of OMNIC.

*

Some dedicated systems use other Thermo Electron software packages.
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About this manual

This manual explains how to use the system to collect and process
FT-IR spectra after a Nicolet 4700 or a Nicolet 6700 spectrometer is
installed. Included is information about using your OMNIC software
as well as chapters on how to operate, maintain and service the
spectrometer.
This manual describes some hardware features that are not available
on all Nicolet models. Use the instructions for the features on your
system.
Although the appearance of your spectrometer may vary from some
of the illustrations in this manual, the instructions are correct for
your system.
The following conventions are used in this manual to draw your
attention to the on-line documentation and other important
information.
This symbol tells you that you can find more information in the online tutorials. To access a tutorial, click the Help menu in OMNIC.

?

This symbol tells you that you can find more information in the online OMNIC Help system. Choose OMNIC Help Topics from the
Help menu.
This symbol tells you that you can find more information in this
manual.
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Note
Important

Caution

Warning

Danger

Questions
or concerns

Notes contain helpful supplementary information. S
Follow instructions labeled “Important” to avoid damaging the
system hardware or losing data. S
Indicates a potentially hazardous situation which, if not avoided,
may result in minor or moderate injury. It may also be used to alert
against unsafe practices. S
Indicates a potentially hazardous situation which, if not avoided,
could result in death or serious injury. S
Indicates an imminently hazardous situation which, if not avoided,
will result in death or serious injury. S

In case of emergency, follow the procedures established by your
facility. If you have questions or concerns about safety or need
assistance with operation, repairs or replacement parts, use the
information below to contact Thermo Electron. Outside the U.S.A.,
contact the local Thermo Electron sales or service representative.
Phone: 1-800-642-6538 (U.S.A.) or
+608-273-5015 (worldwide)
Fax:
+608-273-6883 (worldwide)
E-mail: techsupport.analyze@thermo.com
World Wide Web: http://www.thermo.com/spectroscopy

Nicolet FT-IR User’s Guide
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System requirements

If you are supplying your own computer, be sure that it meets the
following requirements for hardware and software.
●
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One of the following versions of Windows® software:
-

Windows 2000 (latest Service Pack recommended)

-

Windows XP Professional (latest Service Pack
recommended)

●

Microprocessor:
Intel® Pentium® III, 1.0 GHz (recommend)
Intel Pentium II, 400 MHz (minimum)

●

Random access memory (RAM):
256 megabytes (recommended)
128 megabytes (minimum)
If you plan to use a microscope,
1 gigabyte (recommended)
512 megabytes (minimum)

●

Disk drives:
5.0 gigabytes (recommended) hard disk drive
2.0 gigabytes (minimum) hard disk drive
1.44-megabyte floppy disk drive for 3.5-inch floppy disks
Quad speed CD-ROM drive

●

Video:
15-inch SVGA
4 megabytes of video RAM
16-bit video card capable of displaying at least 256 colors with
1024 by 768 resolution

Thermo Electron Corporation

●

IO devices and card slots:
Sound card and speakers for listening to the audio portions of
tutorials
Keyboard and serial, USB or PS/2®-style mouse
Printer port (USB, parallel and/or serial) if you plan to print on a
local printer
One USB 2.0 connector (not a hub) for data transfer
Ethernet port if you plan to connect the system to a network
Internet connection if you plan to use the internet features of the
software
One additional serial port if you plan to use PLUS™ 2 Liquid
Analysis System, Centaurµs microscope with motorized stage, or
standard Continuµm microscope
Two additional serial ports if you plan to use a Continuµm
microscope with a motorized stage
Two additional serial ports and one additional USB 2.0
connection (not a hub) if you plan to use a Continuµm XL
microscope
One additional PCI slot if you plan to use a microscope with
video capability

Installing OMNIC

If you purchased your computer from Thermo Electron, your
software is already installed. If you provided your own computer,
you need to install OMNIC on your hard drive. See the instructions
that came with the software CD, or read “Installing OMNIC or EZ
OMNIC” in the document titled OMNIC Spectroscopy Software that
came with your software. You can use these same instructions if you
ever need to reinstall the software.

Nicolet FT-IR User’s Guide
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Where to find the
information you need

Wizards and tutorials

The on-line and printed documentation included with your system is
designed to let you find the information you need quickly. We
recommend first using the on-line documentation provided with
OMNIC when you have a question. OMNIC includes several on-line
tutorials, a wizard and a complete Help system. See “Starting
OMNIC” in the “Before You Collect Spectra” chapter for
information about starting OMNIC.

The following wizards and tutorials are available on your system.

Getting Started With OMNIC – This tutorial, available through
Getting Started in the Help menu, introduces you to OMNIC. It
includes basic information about the OMNIC window, using the
toolbar and tool palette, creating and using spectral libraries,
creating your own experiment files, and using on-line laboratory
notebooks to create and save reports.
Spectrometer Tour – When you finish this tutorial, you will be
familiar with the major components in your spectrometer. The
tutorial is available through Getting Started in the Help menu.
Beginner’s Guide to FT-IR – Run this tutorial to learn how an FTIR spectrometer works and the theory behind FT-IR spectroscopy.
The tutorial is available through Getting Started in the Help menu.
Sampling Techniques – This item in the Help menu gives you
access to the “Choosing a Sample Technique” tutorial, which helps
you choose the best technique for your analysis. Also available are
tutorials describing how to install and use a number of sampling
accessories, including Smart Accessories.
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Learning OMNIC – This item in the Help menu gives you access to
tutorials that explain how to use OMNIC to collect spectra and
perform a number of other software operations.
Spectrometer Help Topics – This tutorial, available in the Help
menu, contains step-by-step instructions for installing optional
hardware, changing replaceable parts, maintaining your
spectrometer, and setting up the system for a variety of experiments.
If you ever have a problem with your spectrometer, use this tutorial
to access troubleshooting information and get part number and
ordering information.
Technical Support – This tutorial, available in the Help menu,
outlines the many support, training, and custom application services
available from Thermo Electron. It includes Technical Support
telephone and fax numbers, as well as e-mail and web site addresses.
The Library Creation Wizard prompts you, step by step, through
creating a user library of spectra. The wizard appears when you click
the Create Library button in Library Manager, available in the
Analyze menu in OMNIC.

On-line Help

Choose the Help Topics that interest you from the Help menu to
display that Help system. It lets you quickly find answers to your
questions about using the software.
There are several other ways to enter a Help system:

• You can see information about many features in OMNIC (such
as a parameter in a dialog box) by clicking the feature using the
right mouse button. (If the active dialog box or window includes
a question mark button near the upper-right corner, you may
need to first click that button and then click the feature of interest
using the left mouse button.) A brief description of the item
appears, and in most cases one or more buttons that you can click
to display more detailed information. Here is an example:

Nicolet FT-IR User’s Guide
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Click the Discussion button to display a complete discussion of
the item (or the dialog box or window that contains the feature).
Click the How To button to display a step-by-step procedure for
using the item (or the dialog box or window that contains the
item).

• The left pane in each help window lists the topics available in
that help system.
Here is an example of a help window showing the contents of
some of the books in the system:

8
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Finding answers
to your questions
The basics

Use the following sections to help you locate the information you
need in the on-line and printed documentation. The on-line
documentation is available in the Help menu of OMNIC.

How do I turn on the system?
Spectrometer Tour (available through Getting Started)...
“Powering up”
“Before You Collect Spectra” chapter...
“Turning on the system components”

How do I start the software?
“Before You Collect Spectra” chapter...
“Starting OMNIC”

How do I prepare the software for data collection?
Collecting a Spectrum (available through Learning OMNIC)...
“Preparing the Software”

How can I learn how to use the software?
View the tutorials listed when you point to Getting Started or
Learning OMNIC.
?

OMNIC Help Topics includes complete instructions for all the
OMNIC features. Use the Index tab or Contents tab to find the
information you need.
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Using the spectrometer
and changing parts

What’s inside the spectrometer?
Spectrometer Tour (available through Getting Started)...
“Inside the spectrometer”

How does the spectrometer work?
Beginner’s Guide to FT-IR (available through Getting Started)

How do I purge the system?
Spectrometer Help Topics...
“Installing purge controls” in “Installing optional hardware”

How do I use Smart Purge ?
Spectrometer Help Topics...
“Setting the Smart Purge controls” in “Installing optional
hardware”

How do I change beamsplitters?
Spectrometer Help Topics...
“Changing beamsplitters” in “Setting up experiments”
“Selecting a beamsplitter, detector, and source” in
“Setting up experiments”
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How do I change detectors?
Spectrometer Help Topics...
“Selecting a beamsplitter, detector, and source” and
“Changing detectors” in “Setting up experiments”

How do I install a source?
Spectrometer Help Topics...
“Selecting a beamsplitter, detector, and source” and
“Installing a new source” in “Setting up experiments”

Collecting spectra

Which beamsplitter and detector should I use?
Spectrometer Help Topics...
“Selecting a beamsplitter, detector, and source” in “Setting up
experiments” (See the tables showing the compatibility of
sources, beamsplitters and detectors.)
“Spectrometer Basics” chapter...
“Selecting the right beamsplitter and detector” in “Using
beamsplitters and detectors”

How do I install a sample?
Spectrometer Tour (available through Getting Started)...
“Installing samples”

Nicolet FT-IR User’s Guide
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How do I collect a spectrum?
Collecting a Spectrum (available through Learning OMNIC)

“Your First Experiment” chapter

Accessories

What accessories are available?
Spectrometer Tour (available through Getting Started)...
“Accessories”
“Accessories” chapter
How do I install an accessory?
Spectrometer Help Topics...
“Installing optional hardware” (Step-by-step instructions and, in
many cases, on-line videos help you install accessories. If your
accessory is not covered on-line, use the printed instructions.)

12

Thermo Electron Corporation

Maintenance and service

How should I maintain my spectrometer?
Spectrometer Tour (available through Getting Started)...
“Service and maintenance”
Spectrometer Help Topics...
“Maintaining your spectrometer”
“Maintenance and Service” chapter
What should I do if there is a problem with the system?
Contact Thermo Electron technical support. Outside the U.S.A.,
contact the local Thermo Electron sales or service representative.
Phone: 1-800-642-6538 (U.S.A.) or
+608-273-5015 (worldwide)
Fax:
+608-273-6883 (worldwide)
E-mail: Techsupport.analyze@thermo.com
World Wide Web: http://www.thermo.com/spectroscopy
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Before You Collect Spectra
Warning

The Spectrometer Safety Guide that came with your system contains
important safety information. This guide is available in several
languages. Contact your local Thermo Electron office for
information about the languages that are available. Before you use
the system, read the entire guide. To prevent personal injury and
damage to equipment, follow the safety precautions contained in the
guide whenever you use the system. S
It’s easy to collect spectra with your spectrometer. By leaving the
system turned on at all times—with the needed components already
installed—you can keep it ready to use with a minimum of
preparation. Keeping the system on also improves its stability and
gives you more consistent results.
All the things you need to check before collecting spectra are listed
below; each of these items is discussed in a section of this chapter. By
the time you have run through these items once or twice in the course
of your work, you will know how to check the system and start
collecting spectra quickly.

• Check the purge or desiccant.
• Make sure the system components are powered on.
• Cool the detector (if you are using an MCT, InSb or other
•
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detector that requires cooling with liquid nitrogen).
Start OMNIC and select an experiment.

Checking the purge
Skip this section if you purchased
the “Sealed and Desiccated” option.

If your spectrometer is purged but you don’t have the Smart Purge
option, make sure the pressure regulator is set between 20 and
40 pounds per square inch (psi) and the flowmeter reads
approximately 30 standard cubic feet per hour (scfh). The settings for
systems equipped with Smart Purge are given in the next section; read
this section first.
If you need to adjust the flow rate, or if your application requires a
different flow rate, follow the instructions in “Setting the purge gas
controls” in the “Setting up experiments” book in Spectrometer Help
Topics.

Warning

Never use a flammable gas to purge the spectrometer. The purge gas
must be free of moisture, oil, carbon dioxide and other reactive or
infrared-absorbing materials. Use dried air or nitrogen to purge the
spectrometer. Other gases, even inert gases such as argon, can
damage the spectrometer and should never be used for this purpose. S
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We recommend that you leave the purge on at all times. This keeps the
spectrometer free of undesirable gases, protects the optics and
improves the system’s thermal stability.
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In Spectrometer Help Topics view “Installing optional hardware” for
information about installing purge equipment and setting the
controls for the first time. “Maintaining your spectrometer” contains
information about inspecting and replacing the purge filter. In the
Spectrometer Tour (available through Getting Started) view “Sample
compartment” for information about using Smart Purge.

Smart Purge settings

The Smart Purge option increases the purge gas flow rate when you
install or remove samples. If you have this option, set the pressure
regulator to 80 psi. The auxiliary tank may be required depending on
the flow rate supplied by your purge gas source. See the following
table for details.

Flow Rate*

Tank Required?

Comments

less than
50 scfh

yes

Some purge gas and pure air
generators provide a flow rate of
less than 50 scfh.

50-99 scfh

optional

Using the tank will improve
performance.

100 scfh or
greater

no

A flow rate of 100 scfh gives the
best results.

* Flow rates greater than 50 scfh cannot be measured with the flowmeter installed by
Thermo Electron. See your air dryer manual or contact the department that maintains your
purge equipment if you don’t know the flow rate of the purge gas source.

?
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You can use OMNIC to set the duration of increased purge flow. In
OMNIC Help Topics find “purge” in the Index and go to “Setting
Smart Purge.”
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Checking
the desiccant

If your spectrometer is sealed and desiccated, a bag of desiccant is
located under the beamsplitter compartment cover. The desiccant
protects the beamsplitter and other optical components by reducing
the amount of water vapor inside spectrometer. See “Checking and
changing desiccant” in the “Maintaining your spectrometer” book in
Spectrometer Help Topics if you need to change the desiccant.
If your spectrometer is in use, check the humidity level inside it
monthly (more often in very humid climates) by clicking the Check
Desiccant button on the Diagnostic tab of the Experiment Setup
dialog box. If the level exceeds the factory-specified limit, a
message informs you. Be sure to change the desiccant so that the
optics will be protected.

If your spectrometer is in storage, check the round, blue indicator on
the desiccant holder under the beamsplitter compartment cover
monthly. Change the desiccant if the indicator has turned pink. Keep
all covers closed tightly while the spectrometer is in storage.
Note

The Check Desiccant button measures humidity more accurately
than the indicator. For this reason you should rely on the button to
monitor the performance of the desiccant when the spectrometer is
in use. Rely on the indicator only when the spectrometer is in
storage. S
See “Ordering parts” in Spectrometer Help Topics to find the part
number for ordering desiccant bags.

Nicolet FT-IR User’s Guide
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Turning on the
system components

We recommend that you keep your spectrometer on at all times,
unless the building is subject to power outages or you need to
perform a service or maintenance procedure. Leaving the system on
keeps it stable and gives you the most consistent results. If you must
turn the spectrometer off, allow it to stabilize for at least 15 minutes
(one hour for best results) before collecting spectra.
Follow these steps to turn on the system components:
1. If the external power supply is not already connected,
connect it.
In the Spectrometer Tour (available through Getting Started)
view “Connecting to AC power” in the “Powering up” unit for
information about connecting the power supply.

2. Turn on any accessories you plan to use.
This includes accessories such as a gas chromatograph, a GC
interface or an infrared microscope.

Warning

Always follow the safety precautions described in this manual and in
the Spectrometer Safety Guide that came with your system. S
3. Turn on the spectrometer by pressing the power switch (I/O)
on the external power supply to I.
When you turn on the spectrometer, the four status indicators—
Power, Scan, Laser and Source—flash in various sequences as the
system runs through its diagnostic routines. When the routines are
finished, the Power, Laser and Source indicators stay lighted. The
Scan indicator flashes with each scan of the interferometer.
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After you turn on the spectrometer, let it stabilize for at least
15 minutes (one hour for best results) before collecting spectra.
See “Turning on the spectrometer power” in the “Spectrometer
Basics” chapter if you need more information.

4. Turn on the printer and then the computer.
Turn on the printer and computer as explained in the
documentation that came with those components.
Reverse the order given in the preceding procedure when you turn
off system components:
1.
2.
3.
4.

Turn off the computer.
Turn off the printer.
Turn off the spectrometer.
Turn off the accessories.

Cooling the detector

Some detectors, such as an MCT or InSb detector, require cooling
with liquid nitrogen. In Spectrometer Help Topics view “Cooling a
detector” in “Setting up experiments” for instructions.

Warning

Liquid nitrogen is extremely cold and therefore potentially
hazardous. Avoid contact with skin. Wear protective clothing and
follow standard laboratory safety practices to prevent injury. Liquid
nitrogen can be hazardous if handled in an insufficiently ventilated
room. S
After you fill the detector dewar with liquid nitrogen (the dewar
holds about 750 mL), allow the detector to cool at least 20 minutes
before collecting spectra.

Nicolet FT-IR User’s Guide
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Starting OMNIC

Follow these steps to start OMNIC:
1. Start your Windows software.
Depending on the version of Windows you are using, you may
be required to enter your user name and password. Enter the
information when you are prompted.

2. Double-click the OMNIC shortcut on the Windows desktop.

Alternatively, you can click the Start button on the Windows
taskbar, point to Programs (All Programs in Windows XP), point
to the Thermo Nicolet folder, and then click the OMNIC
program.
Depending on how the program has been configured, dialog
boxes may appear asking for a user name and password. Type
the requested information and then choose OK.
The OMNIC window appears. This window is described in the
next chapter and in the “Getting Started With OMNIC” tutorial
available through Getting Started in the Help menu.

20
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Selecting
an experiment

The parameter settings for collecting spectra are stored in
experiment files. You load the settings you wish to use when you
select an experiment from the Experiment drop-down list box below
the OMNIC menu bar (see the example below).

A number of experiments are included with OMNIC for performing
a wide variety of data collections. You can open these experiments
by choosing Open in the Experiment Setup dialog box. Experiment
Setup is available in the toolbar and in the Collect menu. You can
also use Experiment Setup to set up and save your own experiments,
or to check or change the parameter settings after you select an
experiment.
If you install a Smart Accessory , the correct experiment is selected
automatically (or a list of appropriate experiments is made available
for your selection).
In the tutorial in the next chapter the Default - Transmission (or
Transmission E.S.P.) experiment is used. You will probably find that
this experiment is suitable for most of your applications.
If you want to check or change the parameters after selecting an
experiment, use Experiment Setup in the Collect menu.

Nicolet FT-IR User’s Guide
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You are now ready to collect spectra.
If you have not used the system before, you can learn how to
perform an experiment by viewing the “Collecting a Spectrum”
tutorial (available through Learning OMNIC in the Help menu) or
by using the tutorial in the next chapter of this manual. If you need
to change a source or detector, view “Replacing the source” or
“Replacing the detector” in the “Servicing your spectrometer” book
in Spectrometer Help Topics.
Note
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The most commonly used hardware configuration for mid-IR
experiments includes a KBr beamsplitter, an ETC source and a
DTGS detector. You may need to change the settings of the example
experiment if your hardware configuration is different. S
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Your First Experiment
This chapter will get you started collecting spectra with your
spectrometer and working with the data using OMNIC. You will
learn how to do the following things:

•
•
•
•
•
•
•
•
•
•

Open a configuration.
Select an experiment.
Collect a sample spectrum.
Save the spectrum.
Convert the spectrum to other units.
Label a peak in the spectrum.
Verify the composition of the sample by comparing the spectrum
with spectra in a QC library.
Create a user library.
Add the spectrum to a user library.
Create and print a report containing the spectrum.

You can learn all these things and more by running the on-line
tutorials provided with OMNIC. Start with the Spectrometer Tour
and Getting Started With OMNIC (available through Getting
Started).
Follow the instructions in the preceding chapter to prepare the
system and start OMNIC before using this chapter.
Note

If you have a dedicated system (such as an ECO/RS) that normally
uses a software package other than OMNIC, skip this chapter. See
the special documentation that came with your system for
instructions for using that software. If you need information about
using the spectrometer, see the chapters that follow this one. S

Nicolet FT-IR User’s Guide
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The OMNIC window

The large window that appears on the screen when you start OMNIC
is called the OMNIC window.

Spectral window

Within the OMNIC window is a spectral window, which you can use
to display and manipulate spectra. When a spectrum is displayed in a
spectral window, you can use OMNIC commands to perform
operations on it. For example, you can change the spectrum’s format
or search it against a spectral library to identify it.

Thermo Electron Corporation

Menu bar

Below the title bar is the menu bar, which contains all of the
OMNIC menu names. (Depending on which optional software you
purchased, the menu names in your menu bar may be somewhat
different from those shown.) The menus are arranged in an order that
you’ll find convenient as you use the software. All of the menu
commands are explained in detail in the on-line tutorials or the
OMNIC Help system.

Experiment
drop-down list box

Below the menu bar is the Experiment drop-down list box. It lists all
of the experiment files you have opened, plus the default experiment
file and an experiment file for any Smart Accessory module you
have installed. By selecting an experiment with this feature, you can
quickly set the software parameters for the type of experiment you
want to perform. You can see the parameter settings for the selected
experiment by using Experiment Setup, available in the toolbar or in
the Collect menu.

Nicolet FT-IR User’s Guide
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Bench Status indicator

To the right of the Experiment drop-down list box is the Bench
Status indicator.

If the indicator is a green check mark, the spectrometer has passed
all of its diagnostic tests.
If the indicator is a yellow circle, a cooled detector in the
spectrometer has become warm. A message appears explaining the
problem and allowing you to access information about correcting it.
If the indicator is a red X, the spectrometer has failed a diagnostic
test and requires corrective action. A message appears explaining the
problem and allowing you to access information about correcting it.
Note

Toolbar

?
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If you want to view the on-line videos to help troubleshoot a
problem, put the spectrometer’s Tutorial CD into the computer’s
CD-ROM drive. S

At the left side of the window is the toolbar. (You can use Edit
Toolbar in the Edit menu to position the toolbar at the top or right
side of the OMNIC window as well. Each button in the toolbar
represents a command or other feature. To see the name of the
command or feature, point to the button and wait a moment. To
initiate the command or feature, click the button with the left mouse
button.
In OMNIC Help Topics find “toolbar” in the Index and go to
“Displaying and using a toolbar” for information about using and
customizing the toolbar buttons.
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Collecting a
sample spectrum

A sample spectrum is usually ratioed against a background
spectrum. The background spectrum measures the response of the
spectrometer without a sample in place. Dividing the sample
spectrum by the background—called “ratioing”—removes the
effects caused by the instrument and atmospheric conditions so that
the peaks in the final spectrum are due solely to the sample.
Here is a typical mid-IR background spectrum:

For most applications you don’t need to collect a new background
spectrum for each sample spectrum if you haven’t changed the
software parameters. To obtain good results, however, collect a new
background regularly, perhaps once every four hours. (You can
obtain the best results by collecting a new background for each
sample, but this is usually necessary only if you are running
quantitative experiments.)
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Installing the
standard sample holder

If the standard sample holder is not already installed, install it now.
The following illustration shows the sample holder in place.

Accessory
support

Sample
holder
Height
adjustment
screw

If you are using separate Snap-In™ sample compartment baseplates
for different accessories and sample holders, you can quickly switch
baseplates to install the sample holder. For information about using
Snap-In baseplates, view “Removing the Snap-In baseplate” in
“Setting up experiments” in Spectrometer Help Topics.
If your sample holder is mounted on a Smart baseplate, the
Transmission E.S.P. experiment is automatically selected when you
install the baseplate in the sample compartment.
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If your sample holder is not installed on a baseplate, use a flat-blade
screwdriver and the slotted screws to attach the holder to a baseplate
as shown below. Then install the baseplate in the sample
compartment.

If there is a sample in the
holder, remove the sample.

To install a sample or filter, slide the sample or filter into one pair of
slots. If the accessory support is currently installed in the slot you
want to use, remove the support before installing the sample or filter
(see the first illustration in this section). Replace the support when
you are finished using the slot. Do not discard the support; it is
needed for installing slide-mounted accessories.
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Collecting the
sample spectrum

In the data collection procedure that follows, you will collect a
background spectrum and then a spectrum of the secondary
polystyrene standard that came with your spectrometer. Before
collecting the spectra, you will open a configuration that sets a
number of software options for this procedure.
You can also learn how to collect spectra by viewing Collecting a
Spectrum (available through Learning OMNIC).
Follow these steps:
1. Choose Open Configuration from the File menu.
The Open Configuration dialog box appears listing the available
configuration files. Opening one of these files lets you quickly
set a number of software options.

2. Select the DEFAULT.CON file and then choose OK.
This file was provided with your OMNIC software for setting the
options for this procedure.

3. If it is not already selected, select the Default - Transmission
experiment (or the Transmission E.S.P. experiment).
Both of these experiments set the parameters correctly for
collecting a polystyrene sample spectrum. The currently selected
experiment is shown in the Experiment box near the top of the
OMNIC window.
To select the Default - Transmission (or Transmission E.S.P.)
experiment, first click the arrow button at the right end of the
Experiment drop-down list box. The Default - Transmission (or
Transmission E.S.P.) experiment appears in the list.
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Select the Default Transmission experiment by clicking it.

A number of other experiments are provided with OMNIC for
performing a wide variety of data collections. You can select
these experiments by using the Open button in the Experiment
Setup dialog box. After you have selected one of them the first
time, the experiment will appear in the Experiment drop-down
list for future selection. You can also set up and save your own
experiments.

4. Press the Sample button on top of the spectrometer to start
sample data collection.

You can also click the Collect Sample button in the toolbar or
choose Collect Sample from the Collect menu.
The Collect Sample window appears and then a dialog box
showing the default title for the sample spectrum:
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5. Type a title in the text box and choose OK, or just press the
OK/Enter button on top of the spectrometer to accept the
default.

Since the experiment you are using specifies that a background
be collected before every sample, a message appears asking you
to prepare to collect a background spectrum:

This means that you need to remove any sample from the sample
holder so that the beam path is clear. When you then collect a
background spectrum, the result is a measurement of the
response of the spectrometer alone; that is, without absorptions
due to a sample.
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6. Look through the sliding door to make sure there is no
sample in the sample holder and then press the OK/Enter
button to start data collection.
If there is a sample in the sample holder, remove it before
pressing the button:
If your spectrometer is purged but does not have the Smart
Purge option...
Open the sliding door, remove the sample, close the sliding
door and then wait 1 minute before choosing OK.
If your spectrometer has the Smart Purge option...
Open the sliding door, remove the sample and then slide the
door until it is open about 1 cm. When you hear the purge
flow rate return to normal, close the door all the way and
choose OK.
If your spectrometer is sealed and desiccated...
Open the sliding door, remove the sample, close the sliding
door and then choose OK.
A background spectrum appears in the Collect Sample
window. The spectrum is updated as more data are collected.
When all the data have been collected, a message appears
asking you to prepare to collect the sample spectrum:
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7. Install the thin film polystyrene sample labeled “Secondary
Polystyrene Standard: 1.5 mil Polystyrene” through the
sliding door, wait if necessary (see the instructions below)
and then press the OK/Enter button.

If your spectrometer is purged but does not have the Smart
Purge option...
Open the sliding door, install the sample, close the sliding
door and then wait 1 minute before choosing OK.
If your spectrometer has the Smart Purge option...
Open the sliding door, install the sample and then slide the
door until it is open about 1 cm. When you hear the purge
flow rate return to normal, close the door all the way and
choose OK.
If your spectrometer is sealed and desiccated...
Open the sliding door, install the sample, close the sliding
door and then choose OK.
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For more information about installing samples, view “Installing
samples” in the Spectrometer Tour (available through Getting
Started).
As data are collected, the sample spectrum in the Collect Sample
window is updated. Here is an example:

The progress of the collection is indicated by the gauge below
the spectrum.

The number of scans collected so far and the total number of
scans for the collection are displayed to the right of the gauge.
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When data collection is finished, a message may appear, asking
whether to add the spectrum to a spectral window.
Note

If Collect To A New Window is selected in the Collect options
(available through Edit Options in the Edit menu), this message does
not appear since the spectrum is placed into a new spectral window
automatically. S

8. Press the OK/Enter button to add the sample spectrum to the
spectral window.
Choosing No would end the procedure without saving the
spectrum. Choosing More Scans would return you to the Collect
Sample window, allowing you to collect more scans with the
More button. Choosing View Collect Status would display
information about the collection, including any problems that
occurred (see the next section).
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How do I know if
my spectrum is good?

The Collect Status indicator near the bottom of the Collect Sample
window shows the status of the collection. When the indicator is a
green check mark, it shows that the spectrum has passed all of the
selected spectral quality checks made so far. After the collection is
finished and the indicator is a green check mark, you can add the
spectrum to a spectral window (if it is not added automatically).
If you ever have a problem with data collection while one or more
quality checks are turned on, the Collect Status indicator may
change. If the indicator is a yellow circle, the spectrum has failed a
spectral quality check (a measured value was not within the allowed
range), but it is not serious enough to stop the collection. If the
indicator is a red X, there is a problem with the quality of the
spectrum. After correcting the problem, collect the spectrum again.
To view information about the collection, including a list of any
problems that have occurred, click the Collect Status indicator
during or after the collection. You can also click the View Collect
Status button in the message that may appear when the collection is
finished (see step 7 of the procedure in the preceding section). For
each listed problem, an Explain button is provided to let you access
troubleshooting information.

Saving the spectrum

You can save your spectrum on the hard disk by using either of two
commands in the File menu: Use Save when you want to save a
spectrum using the current filename and path. Use Save As when
you want to save a spectrum using a new filename or path.
Follow these steps to save the spectrum you just collected:
1. Select the polystyrene spectrum by clicking it.

2. Choose Save As from the File menu.
The Save As dialog box appears.
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3. Type a descriptive name (such as POLY.SPA) following the
directory path in the File Name box.
Here is an example:
C:\My Documents\OMNIC\Spectra\POLY.SPA
The text can be either upper or lower case. The default directory
path for saving files is determined by the settings on the File tab
of the Options dialog box, available through Options in the Edit
menu.

4. Choose OK.
If you typed a filename that already exists in the directory, a
message appears asking whether to replace the existing file.
Choose No and then use a different filename to save the
spectrum.

Converting the
spectrum’s units

The sample spectrum you collected is in absorbance units. Since many
of OMNIC’s data manipulation commands work best on spectra in
absorbance units, it is often useful to convert a spectrum to absorbance
by using the Absorbance command. In this example you will convert
the spectrum to % transmittance and then back to absorbance.
1. Select the spectrum by clicking it.

2. Click the % Transmittance button in the toolbar.

You can also
choose % Transmittance
from the Process menu.

38

Thermo Electron Corporation

The spectrum is converted to % transmittance units:

?

The Process menu allows you to convert spectra to several other
units as well. These units are discussed in detail in the OMNIC online Help system. In OMNIC Help Topics find “converting
spectrum” in the Index and go to the topic that deals with the units
you are interested in.
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3. Click the Absorbance button in the toolbar to return the
spectrum to absorbance units.

You can also choose
Absorbance from the Process menu.

In the next section, you will label a peak in the absorbance
spectrum using the annotation tool.

Labeling a peak with
the annotation tool

The palette contains six tools that let you select a spectrum or
spectral region, change how spectra are displayed in a spectral
window, find the height or area of a peak, or label a peak. The names
and appearance of the palette tools indicate their functions.

Region

Selection

Peak height

Spectral cursor

Annotation

Peak area

Only one tool can be used at a time. To use a tool, first select it by
clicking it. A tool remains selected until you select another tool.
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When you use a tool, the readout above the palette may display
information for the tool operation, such as the X and Y values of the
pointer location or the limits of the selected spectral region. Here is
an example of X and Y values displayed in the readout when the
selection tool is selected and the pointer is within the spectral
display:

Follow these steps to label a peak in the polystyrene spectrum:
1. Select the annotation tool by clicking it.

The annotation tool lets you label peaks with their frequency
locations (X values) or other information.
When the annotation tool is selected and you move the pointer
into the spectral display, the pointer looks like this:

You can label a peak by clicking above it with the annotation
tool. This displays the label text above the peak with a line
connecting the label to the peak. The text is selected so that you
can immediately edit it. When you press Enter, the label appears
in its final form.
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You can more accurately locate the top of a peak by holding
down the Shift key when you click near the peak.

2. Label a prominent peak by holding down the Shift key and
clicking a little above the peak.
The label appears. Here is an example:

3. Press Enter to accept the label text.
You could also perform other operations on the label using the
annotation tool. To modify a newly created label, edit the
selected text before pressing Enter. To modify an existing label,
click it and then type a new label and press Enter. To delete an
existing label, click it and then press the Delete key.
?

In OMNIC Help Topics find “tool, annotation” in the Index and go
to “Annotation tool” for more information about the annotation tool.
In the next section, you will compare the spectrum with the
spectra in a QC library to verify the composition of the sample.
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Verifying the
composition
of the sample
Note

You can verify the composition of your polystyrene sample by
automatically comparing the collected spectrum with the spectra in a
QC (Quality Control) library. The software compares the sample
spectrum with reference spectra in the appropriate category in the
library and then tells you whether the sample matches a library
spectrum.
If you were unsure of the composition of the sample, you could
perform a “spectral search” using a search library. In that case, the
software would search the library and then display a list of the
library spectra that best matched the unknown spectrum. S
Follow these steps to perform a QC comparison:
1. Select the spectrum by clicking it.

2. Choose Library Setup from the Analyze menu.
The Library Setup dialog box appears with the Search Libraries
tab displayed.
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The Library Directories box lists the directories that are currently
being used for spectral searches and QC comparisons. All the
libraries in the listed directories are available for your QC
comparison.

3. Add the LIBS directory (within the OMNIC directory) to the
list of directories if it is not already in the list.
This is the directory that contains the provided Polystyrene
Quality Control Sample library. To add the directory to the list,
choose Add Directory. In the dialog box that appears, locate and
select the LIBS directory, and then choose OK.

4. Click the QC Libraries tab to display the available QC
libraries.
The available QC libraries appear in the Available QC Libraries
And Groups box.
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The libraries listed in the QC Libraries And Groups box are the
libraries with which your spectrum will be compared.

5. Add the Polystyrene Quality Control Sample library to the
comparison list.
To do this, click the appropriate library name in the Available
QC Libraries And Groups box, and then click the Add button.

6. Choose QC Compare in the Library Setup dialog box to start
the comparison.
You can also close the Library Setup dialog box and begin a QC
comparison at any time by choosing QC Compare from the
Analyze menu.
When you begin a comparison, the QC Compare window
appears. At the bottom of the window a gauge shows the
progress of the comparison.
When the comparison is finished, the sample spectrum and the
library spectrum that best matches it are displayed in panes in the
upper portion of the window. Comments about the comparison
appear in the lower portion of the window. Here is an example:
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7. Close the QC Compare window by choosing Close.
?
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In OMNIC Help Topics find “QC comparison” in the Index and go
to “Performing a QC comparison” if you want more information
about comparing sample spectra with QC libraries.
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Creating a
user library

OMNIC’s Library Creation Wizard makes it easy to create your own
spectral libraries. Creating your own library lets you customize the
information in the library depending on your needs. You set the
library parameters (including the resolution and spectral range) and
specify which checks and corrections to perform. The wizard leads
you step by step through the process.
If you are using OMNIC, start the Library Creation Wizard by
choosing Library Manager from the Analyze menu and then clicking
the Create Library button on the Library Names tab.

?

In OMNIC Help Topics find “library, creating” in the Index and go
to the “Creating a user library” topic for more information.

Adding a spectrum
to a user library

Once you have created a user library, you can use the library to store
spectra you have collected. To do this, select the spectrum and then
choose Add To Library from the Analyze menu. To move a copy of
a spectrum you have collected from one user library into another,
use Library Manager in the Analyze menu.

Note

You cannot add spectra to a commercial library, nor can you move
copies of commercially collected reference spectra into libraries you
create. S

?

In OMNIC Help Topics find “adding, spectrum to user library” in
the Index and go to the “Adding a spectrum to a user library” topic
or the “Adding user library spectra to another user library” topic for
more information.
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Creating and
printing a report
?

OMNIC makes it easy to create and print a report containing the
results of your work. Follow the steps below.
You can also view the “Creating Reports” tutorial (available through
Learning OMNIC in the Help menu) to learn how to create and print
reports and add them to report notebooks.
1. Choose Template from the Report menu.
A dialog box appears allowing you to select a report template for
the report.

2. Select the report template file named QCCOMP.RPT.
This file contains a report template specially set up for this
procedure. The template has items for the spectral window,
spectrum time, title and comments, and QC comparison results.
When you select the template file, a preview image of the
template appears at the right. This feature allows you to see what
different templates look like so that you can pick one with the
items you need for your report. You can view the image as a
graphical layout by selecting the Layout option. This shows you
how the printed report will look on paper. You can also view the
image with template items labeled by selecting the Description
option. This lets you identify items that are too small to be seen
clearly.

3. Choose Select to make the example template the current
template for printing reports.
When you print your report, OMNIC will automatically fill in
the items in the template with the appropriate information and
images. For example, if an item in the template is linked to the
active spectral window, the contents of that window are included
when you print the report.
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You can create your own report templates by using the Create
button, or you can modify one of the existing templates
whenever you want to design a new template. Save the template
with a new name after you make your changes.
?

In OMNIC Help Topics find “report template, selecting” in the
Index and go to “Selecting, editing or creating a report template” for
more information about using reports.

4. Choose Preview/Print Report from the Report menu.
A preview of the report appears showing the report items filled
in with information about your spectrum. Your report should
look similar to this:

You can click the Zoom button to
see an enlarged image of the report.

Collection time:

The preview lets you check the content of the report before
printing it.
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5. If you have a printer connected to the computer, choose Print
to print the report.

The Print dialog box appears allowing you to set some
parameters that affect printing.

6. Choose OK.

The report is printed on your system printer.
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Spectrometer Basics
This chapter describes the major components of your Nicolet 4700
or Nicolet 6700 spectrometer, including the light source,
beamsplitter and detector. It then explains what you will need to
know before collecting data in various spectral ranges.
In the Spectrometer Tour (available through Getting Started) view
“From the front,” “The back panel” and “Inside the spectrometer”
for complete descriptions of your spectrometer’s internal and
external components.

Spectrometer
components

The following illustration identifies some major components visible
on the outside of a typical Nicolet 6700 spectrometer. (Some
components may not be present on your spectrometer.)

Status indicators
Sliding door

Detector fill ports

Detector
compartment

Data collection
buttons
Beamsplitter
and desiccant
compartment

Emission port for
external source
Sample
compartment

External beam port
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For more information about the Auxiliary pass-through connectors,
see the “How to cable an accessory” section of the “Accessories”
chapter.

Using the
data collection buttons

52

The buttons on the top of the spectrometer let you quickly perform
some basic operations with the spectrometer without using your
keyboard or mouse. (OMNIC must be running.)
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Press the Sample button to collect a sample spectrum. This has the
same effect as choosing Collect Sample from the Collect menu. In
OMNIC Help Topics find “spectrum” in the Index and go to
“Collecting a sample spectrum” for more information.
Press the Background button to collect a background. This has the
same effect as choosing Collect Background from the Collect menu.
In OMNIC Help Topics find “background spectrum” in the Index
and go to “Collecting a background spectrum” for more information.
Press the OK/Enter button to respond affirmatively—for example, to
a software prompt—during data collection. This has the same effect
as choosing OK (or other affirmative response, such as Yes) within
the software.
Press the Stop button to respond “Cancel” or “No” to a software
prompt during data collection. This has the same effect as choosing
Cancel or No within the prompt.
Press the Macro button to start a macro you have specified with the
Macro for Macro button field on the Advanced tab in Experiment
Setup. In OMNIC Help Topics find “macro” in the Index and go to
“Specifying a macro for the Macro button” for more information.
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What’s inside?

The illustration below shows a top view of the optical layout of a
typical Nicolet 6700 spectrometer with covers removed to reveal
components. (Some components may not be present in your
spectrometer.)
Interferometer

Laser

Beamsplitter
Beamsplitter
storage

Electronics

Fixed mirror
or optional
emission optics
External
emission port

Passport optics
(optional)
Sample
compartment

Filter wheel
(optional)

External
beam port

External
beam port

Back
detector

Aperture
Energy screen
wheel (optional)

Detector
mirror

Infrared source
Front detector

Source select
optics (optional)
Near-IR source
(optional)

Sample holder

Polarizer
(optional)

SabIR port

Fixed mirror or optional
SeaPort optics

In the Spectrometer Tour (available through Getting Started) view
“Inside the spectrometer” for complete descriptions of your
spectrometer components.
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What is on
the rear panel?

Danger

The rear panel includes a power connector, right-and left-side
accessory connectors, computer connector (USB 2.0, not a hub),
auxilliary signals connector, and purge gas input. You may also find
optional Auxilliary and/or dual channel connectors on the rear panel.

Avoid shock hazard. Always power off the spectrometer and
disconnect the power supply from the wall outlet or power strip
before disconnecting the power supply from the back of the
spectrometer.

In the Spectrometer Tour (available through Getting Started) view
“The back panel” for complete descriptions of the rear panel
components.
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Turning on the
spectrometer power

Follow these steps to turn on the spectrometer power:
1. If the external power supply is not already connected,
connect it.

In the Spectrometer Tour (available through Getting Started)
view “Connecting to AC power” in the “Powering up” unit for
information about connecting the power supply.
2. Turn on any accessories you plan to use.

This includes accessories such as a gas chromatograph, a GC
interface or an infrared microscope.
Warning

Always follow the safety precautions in this manual and in the
Spectrometer Safety Guide that came with your system whenever
you use the spectrometer. S
3. Turn on the spectrometer by pressing the power switch (I/O)
on the external power supply.

When you turn on the spectrometer, the four status indicators—
Power, Scan, Laser and Source—flash in various sequences as
the system runs through its diagnostic routines. When the
routines are finished, the Power, Laser and Source indicators stay
lighted. The Scan indicator flashes with each scan of the
interferometer.
Note

After you turn on the spectrometer, let it stabilize for 15 minutes
(one hour for best results) before collecting data. Leave the
spectrometer on at all times, unless the building is subject to power
outages or you need to perform a service or maintenance procedure.
Leaving the spectrometer on increases stability and consistency of
performance. S
4. Turn on the printer and then the computer.
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Reverse the order given in the preceding procedure when you turn
off system components:
1. Turn off the computer.
2. Turn off the printer.
3. Turn off the spectrometer. (Press the power switch on the
external power supply to O.)
4. Turn off the accessories.
In the Spectrometer Tour (available through Getting Started) view
“Powering up” for complete instructions for turning on your system.
Note

The spectrometer enters “stand-by” mode 10 minutes after data
collection activity has ceased. This mode continues for 1 hour. After
1 hour, the interferometer stops scanning and the spectrometer enters
“sleep” mode. The Scan light stays on continuously. Any data
collection activity will cause the interferometer to begin scanning.
Exiting OMNIC also activates stand-by mode. S

Note

If the Power, Laser or Source indicators flash or will not light at all,
or if the Scan indicator will not light, the Bench Status indicator will
show a red X and troubleshooting tips will appear on the screen. If
you cannot resolve the problem by following these tips or by turning
the spectrometer power off and then on, contact Thermo Electron at
one of the numbers below. Outside the U.S.A. call your local sales
or service representative.
Phone: 1-800-642-6538 (U.S.A.) or
+608-273-5015 (worldwide)
Fax:
+608-273-6883 (worldwide)
E-mail: techsupport.analyze@thermo.com
World Wide Web: http://www.thermo.com/spectroscopy S
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Using a light source

The Nicolet 4700 comes with a single infrared light source. The
Nicolet 6700 is available with a single internal source or with
optional dual sources. If your spectrometer does not have the dualsource option, you will need to change sources in order to use a
different internal source.
In Spectrometer Help Topics view “Installing a new source” in
“Setting up experiments” if you need to install or change a source.

Caution

Even after the spectrometer is turned off, the external housings of
working IR sources remain hot for up to 15 minutes. To avoid being
burned, allow the source to cool before touching it. S
The ETC infrared source can be operated in the three modes of
operation described below.
Normal mode – In this mode the temperature of the source is
maintained at an optimal level for normal spectral data collection.
This improves the consistency of your spectral data by ensuring that
the infrared energy level reaching your samples is constant. The
source operates in Normal mode unless you configure it to enter
Turbo or Rest mode at specific times or the spectrometer is in sleep
mode.
Turbo mode – Use this mode if you are analyzing a sample, such as
a thick film, that requires greater infrared energy. This increases the
output of the source, especially in the frequency range around 2,500
wavenumbers. To turn Turbo mode on or off, use the Source
parameter on the Bench tab of the Experiment Setup dialog box,
available through Experiment Setup in the Collect menu. So long as
you are collecting data, the source remains in Turbo until you turn
that mode off. Whenever the spectrometer is in stand-by mode, the
source returns to Normal mode. When the spectrometer enters sleep
mode, the source shifts into Rest mode. This extends the life of your
source. In OMNIC Help Topics find “source” in the Index and go to
“Specifying the source type” for details.
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Rest mode – Rest mode lowers the temperature of the source so that
its life is extended. The source automatically shifts into Rest mode
when the spectrometer moves into sleep mode. You can configure
the source to enter Rest mode at specific times.

When you resume data collection activity, the source automatically
re-enters Normal mode. In OMNIC Help Topics find “source” in the
Index and go to “Extending the life of the source with rest mode” for
details.
You can switch between different internal sources simply by
changing the Source setting on the Bench tab of the Experiment
Setup dialog box. This option lets you collect spectra in the mid-IR
to far-IR range or in the visible to near-IR range. The spectral range
is determined by the source, beamsplitter and detector you are using.
Nicolet 6700 spectrometers with the emission accessory can use an
external source, if one is available. The beam from the external
source passes through the emission port on the right side of the
spectrometer.
?

In OMNIC Help Topics find “source” in the Index and go to
“Specifying the source type” for instructions for using different
sources in your spectrometer.
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Using
beamsplitters
and detectors

A number of beamsplitters and detectors are available for use in the
Nicolet 4700 and Nicolet 6700 spectrometers. You can change the
detector type in either model, but the beamsplitter type can be
changed only in the Nicolet 6700. Not all beamsplitters and detectors
can be used together. Some detectors can accommodate only a
portion of the energy from the source and require changing the
aperture size (on a Nicolet 6700) or installing an energy filter. This
section explains how to select and optimize the performance of
beamsplitters and detectors.
In Spectrometer Help Topics view the appropriate lesson in “Setting
up experiments” if you need to install or change a beamsplitter or
detector.

Selecting the right
beamsplitter and detector

There are two considerations when selecting a beamsplitter-detector
combination: compatibility and spectral range. Combinations are
considered compatible if they provide a detector signal that is large
enough to allow the beamsplitter to be aligned. This does not
necessarily mean a particular combination will provide the
maximum capable sensitivity range of each component.
The following table shows which beamsplitter-detector
combinations perform best and which are compatible.
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BEAMSPLITTER
Near-IR
DETECTOR

Quartz

DTGS
(KBr window)**

X

DTGS
(Csl window)

Mid-IR*

Far-IR

XT-KBr

KBr

Csl

Solid Substrate

OK

Best

Best

OK

X

X

X

OK

OK

Best

X

DTGS
(PE window)

X

X

X

X

OK

Best

MCT-A

OK

OK

Best

Best

OK

X

MCT-B

OK

OK

Best

Best

OK

X

InSb

OK

Best

OK

X

X

X

PbSe

OK

Best

OK

X

X

X

Si

Best

OK

X

X

X

X

PbS

OK

Best

X

X

X

X

InGaAs

OK

Best

OK

X

X

X

CaF2

Best = Optimum beamsplitter-detector combination.
OK = Compatible beamsplitter-detector combination.
X = Incompatible beamsplitter-detector combination.
* A ZnSe beamsplitter may also be used as a mid-IR beamsplitter in extremely
humid environments.
** Valid for room temperature and thermoelectrically cooled versions.
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The next table lists the spectral ranges of compatible beamsplitterdetector combinations.

Spectral Range (cm-1)

Light Range

Beamsplitter

Detector

visible

quartz

PbSe
Si†

13,000 - 2,800*
25,000 - 8,600

ETC, white light
White light

CaF2

PbSe
Si†

13,000 - 2,000*
14,500 - 8,600

ETC, white light
White light

quartz

MCT-A‡
MCT-B‡
InSb‡,§
PbSe
PbS TEC (with SabIR )
InGaAs

11,700 - 2,800*
11,700 - 2,800*
11,500 - 2,800*
13,000 - 2,800*
10,000 - 4,200*
12,000 - 3,800

ETC, white light
ETC, white light
ETC, white light
ETC, white light
ETC, white light
ETC, white light

CaF2

MCT-A‡
MCT-B‡
InSb‡,§
PbSe
PbS TEC (with SabIR)
InGaAs

11,700 - 1,200*
11,700 - 1,200*
11,500 - 1,850*
13,000 - 2,000*
10,000 - 4,200*
12,000 - 3,800

ETC, white light
ETC, white light
ETC, white light
ETC, white light
ETC, white light
ETC, white light

XT-KBr

MCT-A‡
MCT-B‡
InSb‡,§
PbSe
DTGS-KBr
DTGS TEC
InGaAs

11,000 - 600*
11,000 - 400*
11,000 - 1,850*
11,000 - 2,000*
11,000 - 375*
11,000 - 375*
12,000 - 3,800

ETC, white light
ETC, white light
ETC, white light
ETC, white light
ETC, white light
ETC, white light
ETC, white light

near-IR

Continued on next page...
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Source

Spectral Range (cm-1)

Light Range

Beamsplitter

Detector

mid-IR

KBr

DTGS-KBr
MCT-A‡
MCT-B‡
DTGS TEC
DTGS-CsI

7,400 - 350
7,400 - 600
7,400 - 400
7,100 - 350
6,400 - 350

ETC
ETC
ETC
ETC
ETC

CsI¶

DTGS-CsI
MCT-A‡
MCT-B‡

6,400 - 225
6,400 - 600
6,400 - 400

ETC
ETC
ETC

ZnSe

DTGS-KBr
MCT-A‡
MCT-B‡
DTGS TEC
DTGS-CsI

4,000 - 650
4,000 - 650
4,000 - 650
4,000 - 650
4,000 - 650

ETC
ETC
ETC
ETC
ETC

Solid-Substrate

DTGS-PE
Si bolometer

700 - 50
700 - 20

ETC
ETC

far-IR

Source

Notes:
* This spectral range reflects the combination of the ranges of the ETC and white light sources, as well as the limits of the beamsplitterdetector combination. The range achieved using one of these sources will not be as broad as the total range shown.
† Si detectors can be used only with a white light (tungsten-halogen) source.
‡ These detectors must be cooled with liquid nitrogen before use.
§ InSb detectors will not produce a signal under intense light. During installation and alignment, start with the smallest aperture setting.
¶ CsI beamsplitters are extremely hygroscopic (sensitive to moisture).

Nicolet FT-IR User’s Guide

63

Improving the quality
of your spectral data

If you are using the spectrometer for quantitative analysis or other
demanding applications, you are concerned with the precision and
accuracy of your spectra. For these types of applications it is important
that the spectra you collect have high wavelength precision. This
means that the frequency axis (X-axis) location of peaks in a spectrum
is consistently reproducible and within IUPAC (International Union of
Pure and Applied Chemistry) published specifications. You must also
be certain that your spectrometer responds linearly to the samples you
are studying. This means that absorption band intensity is directly
proportional to the number of molecules subjected to the light beam;
thus, as the number of molecules in the beam increases, the detected
absorbance signal also increases at a consistent rate.
If you are studying samples that produce tiny spectral peaks or have
weak spectral features, or if you are looking for small changes in
your samples, make sure the signal-to-noise ratio is high enough to
let you distinguish spectral features from the noise inherent in all
experimental data. This prevents the signals containing spectral
information from being lost among the signals generated by the
random movement of electrons, building vibrations, light source
fluctuations and other such sources.
The next sections explain several ways you can optimize Thermo
Electron detectors to improve the quality of your spectral data.

Improving linearity
and photometric accuracy

Some detectors (including PbSe, Si, MCT-A and InSb detectors) are
highly sensitive and can become saturated or produce a distorted
(non-linear and photometrically inaccurate) signal if the light energy
is not reduced before it reaches the detector element or if the
detector gain is set too high.
Look at a single-beam spectrum in the low-end region around 600 to
375 cm-1. You should see a straight line very near 0 intensity units.
As a rule of thumb, the distance from 0 to the baseline should be less
than 1% of the spectrum’s maximum intensity value. If the detector
is saturated, you will see false energy in the low-end region. The
baseline might be far above zero.

64

Thermo Electron Corporation

Note

The maximum intensity of a mid-IR single-beam spectrum is
typically found near 2,000 cm-1. S

Note

If the distance from the baseline to 0 is greater than 20% of the
spectrum’s maximum intensity value, your detector electronics may
be overloaded. Contact technical support for assistance. S
The distorted signal may cause problems with photometric accuracy.
For good quantitative data, the sample and background
interferograms should be about the same size. Scattering samples
and very dense samples produce very small signals that, when
compared with much larger background signals, can distort
quantitative data.
Check the background and sample interferograms. If you see a
substantial difference in their sizes, photometric accuracy could be a
problem.
To solve these problems, you can use the following options to
modify the infrared beam:

• Use a bandwidth-limiting filter.
• Use an energy screen.
• Adjust the aperture (on a Nicolet 6700).
In Spectrometer Help Topics view “Setting up experiments” for
instructions for using filters and energy screens.
In some cases, system performance improves if you use a filter or
screen. The filter or screen that you should use for your application
depends on the samples being measured and other experimental
conditions. Try using various filters or screens to determine which
give the best results.
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When to use
bandwidth-limiting filters

Use bandwidth-limiting filters to improve the signal-to-noise ratio of
the data and also prevent detector saturation by allowing only energy
in your particular area of interest to pass to the detector element.
An optional filter wheel (available for the Nicolet 6700 only) lets
you automatically move a filter into the beam path before collecting
data. See “Using the filter wheel” in the “Spectrometer Options”
chapter for more information.
In Spectrometer Help Topics view “Setting up experiments” for
instructions for installing filters in the sample compartment or
optional filter wheel.

When to use energy screens

Depending on the types of detectors you use, your system may include
a set of four energy screens. These metal screens help prevent detector
saturation and signal distortion by blocking out a portion of the energy
at all frequencies of the infrared beam. If your experiments deal with
information from a broad range of frequencies, these screens may be
the most effective means of reducing the light level.
The energy screens are labeled A, B, C and D. The following table
shows the percentage of the infrared energy that each screen passes.
It also lists the detectors typically used with each screen, as a
starting point for correcting linearity problems.

Screen

% Transmitted*

None
A
B
C
D

100
30
10
3
1

Detectors Typically Used With Screen

DTGS
MCT-A

* These are nominal values that may vary due to diffraction and detector variations.
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To correct for photometric accuracy, you may need to add a “heavier”
screen (one that transmits less infrared energy). With corrections for
photometric accuracy you will notice some reduction in the signal-tonoise ratio but will obtain more reliable quantitative data. Generally,
the signal-to-noise ratio is reduced less than is the signal intensity.
In Spectrometer Help Topics view “Setting up experiments” for
instructions for installing energy screens in the sample compartment.
An optional energy screen wheel lets you automatically move a
screen into the beam path before collecting data. See “Using the
energy screen wheel” in the “Spectrometer Options” chapter for
more information.

What aperture size
to use for your detector

The aperture in a Nicolet 6700 is a variable-diameter opening that
controls the angular size of the infrared beam and, thus, the amount of
radiation that reaches the sample. Using an aperture has these
advantages:

• It lets you use more sensitive detectors.
• It helps prevent infrared energy saturation, so the response of the
detector is more linear.

• It improves wavenumber accuracy and resolution by acting as a
point source of infrared radiation.
In general you will find that the larger the aperture, the better is the
signal-to-noise ratio of the collected data. The smaller the aperture,
the better the stability and accuracy will be. Small apertures are
needed for high-resolution experiments.
DTGS detectors can accommodate most of the energy from the
source, which means you should use a large aperture size. Detectors
that require cooling with liquid nitrogen are very sensitive and
require a small aperture size or the use of an energy screen (see the
preceding section for more information).
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Note

On a Nicolet 6700, the setting of the Aperture parameter determines
the area of the aperture opening. Doubling the setting approximately
doubles the area. The light energy is proportional to the aperture
area. A setting of 100 gives a nominal aperture diameter of 8 mm
and an approximate area of 0.50 cm2. S
The following table lists recommended aperture settings for different
detectors with the appropriate energy screen installed. (See the
preceding section for information about the correct energy screen to
use for each detector type.) The settings in the table are based on the
physical size of the detector elements and maximize the amount of
infrared energy that reaches the sample. To correct linearity and
photometric accuracy problems, you can reduce the setting, but you
will pay a price in terms of the signal-to-noise ratio.

Detector

DTGS
MCT-A, MCT-B, InSb, PbSe, Si, InGaAs

?
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Aperture Setting

100
32

In OMNIC Help Topics find “aperture” in the Index and go to
“Setting the aperture size” for information about changing the
aperture setting.
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How to improve the
signal-to-noise ratio

If you primarily analyze qualitative data, you may wish to optimize
the system for a better signal-to-noise ratio. This can be particularly
important when you are working with scattering samples and
samples that absorb more infrared energy. These samples produce
smaller signals that can be “lost” in the noise.
There are several ways to improve the signal-to-noise ratio. The
most commonly used method is to increase the number of scans.
This both reduces the noise level and makes small absorptions easier
to distinguish. You can also improve the ratio by reducing the
resolution (that is, using a higher Resolution setting).
Another method is to use an energy screen that transmits more light
(or no screen at all). In this case, the resulting spectrum might be
distorted and accuracy and stability could be reduced. Checking the
single-beam baseline in the region below the low-end cutoff will
give you a rough idea of how much distortion is occurring. If the
distance from the baseline to 0 is more than 15% of the spectrum’s
maximum intensity value, you may have difficulty reproducing the
results.

Note

If the distance from the baseline to 0 is greater than 20% of the
spectrum’s maximum intensity value, your detector electronics may
be overloaded. Contact technical support for assistance. S
In Spectrometer Help Topics view “Setting up experiments” for
instructions for installing filters and energy screens.
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How to improve
the resolution

?

How to collect
data in the visible
spectral range

If you want to achieve higher resolution, you may need to use a
smaller aperture setting (on a Nicolet 6700) and an energy screen that
transmits more light (or no screen at all). Your spectroscopy software
will automatically change the aperture setting if a smaller beam size is
required. Be aware that the smaller beam size will reduce the signal-tonoise ratio.
In OMNIC Help Topics find “aperture” in the Index and go to
“Setting the aperture size” for information about changing the
aperture setting.

The ability of the spectrometer to collect data is affected by the
detector-beamsplitter combination and any energy screens or optical
filters that are installed in the spectrometer. For example, if you use an
optional quartz beamsplitter, a silicon detector and a white-light
source, the sampling range is extended to 25,000 cm-1.
Since silicon detectors are very sensitive, you will also need to
install an energy screen or bandwidth-limiting filter to prevent the
detector from being saturated during the experiment. The following
table lists a variety of spectral bands in the extended spectral range
and lists the filter or energy screen that should be used to obtain data
in each range. It also lists typical aperture and gain settings for
experiments in each range. (Only the Nicolet 6700 has an aperture.)
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Spectral Range

Filter or Screen

16,000 - 9,000 cm-1
16,000 - 9,000 cm-1
23,000 - 16,000 cm-1
26,000 - 21,000 cm-1

red filter
energy screen A
broad-band blue filter
narrow-band blue filter
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Aperture Gain

32
32
100
100

1
1
8
8

You can use these filters and settings as a starting point and vary
them as required by your experimental conditions. To set the
aperture and gain, set the Aperture and Gain parameters on the
Bench tab in the Experiment Setup dialog box.
In Spectrometer Help Topics view “Setting up experiments” for
instructions for installing filters and energy screens.
The optional filter wheel (available for the Nicolet 6700 only) and
energy screen wheel let you automatically move a filter and energy
screen into the beam path before collecting data. See “Using the
filter wheel” and “Using the energy screen wheel” in the
“Spectrometer Options” chapter for more information.

About the moving
mirror velocity

While a wide range of moving mirror velocities are available on
Nicolet 4700 and Nicolet 6700 spectrometers, some velocity settings
cannot be used for collecting data at certain combinations of spectral
range and resolution:
If you are collecting data over a spectral range above 7899 cm-1,
velocity settings faster than 2.53 cm/s are not available.
To specify the velocity and spectral range, set Velocity and Spectral
Range on the Bench tab of the Experiment Setup dialog box. To
specify the resolution, set Resolution on the Collect tab.

Important

When you switch to a different detector (on either model
spectrometer) or beamsplitter (on a Nicolet 6700 only), OMNIC
automatically resets the default spectral range in the Experiment
Setup dialog box. Be sure to check the range and set the velocity to a
value that is appropriate. S

Nicolet FT-IR User’s Guide

71

Spectrometer Options
This chapter explains how to use these optional spectrometer
features:

• The automated filter wheel (available for the Nicolet 6700
only) moves optical filters (supplied by you) into the beam path.

• The energy screen wheel moves an energy screen into the beam
path to reduce the energy reaching the detector.

• The polarizer allows you to control the orientation of the
electric field vector of the infrared beam entering the sample
compartment.

Using the filter wheel
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The optional filter wheel accessory (available for the Nicolet 6700
only) lets you automatically insert optical filters (band-pass, lowpass or high-pass) into the beam path. This lets you reduce the
amount infrared light that reaches the detector in a spectrally
selective way. This is particularly useful for studies of small spectral
regions or for blocking noisy spectral regions that contain no data of
interest. Energy from other regions does not reach the detector, thus
improving the signal-to-noise ratio in the region of interest.
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The accessory has two wheels: wheel A is closest to the source.
Each wheel can be moved to one of four positions. Both wheel A
and wheel B have an open position for collecting spectra without a
filter in the beam path. Positions 1, 2 and 3 are available for filters
that you provide. Each position accepts one 1 mm thick or one 4 mm
thick filter that is 1-inch in diameter. Spacers are provided to secure
1-mm filters in position.
In Spectrometer Help Topics view “Installing an optical filter in the
automated filter wheel” in the “Setting up experiments” book for
instructions for installing filters in the wheel.
Once you have installed your filters, enter their descriptions into
OMNIC using the Filter Wheel table on the Configure tab of the
Experiment Setup dialog box. Be descriptive.

?

In OMNIC Help Topics find “filter wheel” in the Index and go to
“Entering descriptions of the filters in the filter wheel” for more
detailed instructions.
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Your filter descriptions will be saved in the experiment file and are
available for selection through the Filter Wheel A and Filter Wheel
B parameters on the Bench tab of Experiment Setup. Your
descriptions of the filters used during data collection also are saved
in the collection and processing information for the spectra you
collect.
By controlling which position of each wheel is in the beam path, you
can collect spectra with no filter, just one filter or a combination of
two filters. For example, you could install and select a band-pass
filter to block out frequencies in both the high and low ends of the
spectral range, resulting in a spectrum with absorptions only in the
middle of the range. You also could accomplish mid-range data
collection using a high-pass filter installed in one wheel and a lowpass filter installed in the other.
To specify the filter(s) to use for an experiment, set Filter Wheel A
and Filter Wheel B on the Bench tab of the Experiment Setup dialog
box (available through Experiment Setup in the Collect menu).
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Using the
energy screen wheel

In OMNIC Help Topics find “filter wheel” in the Index and go to
“Controlling the filter wheel” for more detailed instructions.

The optional energy screen wheel lets you automatically insert an
energy screen into the beam path to block out a portion of the energy
at all frequencies of the infrared beam. This is useful for preventing
detector saturation and signal distortion. For more information about
using energy screens, see “When to use energy screens” in the
“Spectrometer Basics” chapter.

The wheel can be moved to any of four positions: an open position
(for collecting spectra without a screen in the beam path) and 3
screen positions. As shipped from the factory, the screen positions
are populated with 30%, 10%, and 3% screens. The Screen Wheel
parameters in Experiment Setup to describe the percentage of light
transmitted by each screen installed in the wheel. Simply select one
to move the screen into the beam path.
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To specify the screen to use for an experiment, set Screen Wheel on
the Bench tab of the Experiment Setup dialog box (available through
Experiment Setup in the Collect menu).
?

In OMNIC Help Topics find “energy screen wheel” in the Index and
go to “Controlling the energy screen wheel” for complete
instructions.

After you have moved a screen into the beam path, you can see its
effect on the signal intensity in the live display on the Bench tab.
This helps you select the optimum screen for a particular sample.
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A 1% screen also is shipped with the wheel. Contact technical
support if you wish to use this or other screens that you provide in
the wheel. If you use the 1% screen or one of your own, be sure to
change the description of the screen position on the Configure tab.
?

In OMNIC Help Topics find “energy screen wheel” in the Index and
go to “Specifying the energy screens in the energy screen wheel” for
more detailed instructions.
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Using the
internal polarizer

Note

An optional automated polarizer lets you automatically control the
orientation of the electric field vector of the IR beam entering the
sample compartment. The range of orientation is 0 to 180 degrees
in increments of 1 degree. At 0 degrees, the electric field vector is
oriented vertically, perpendicular to the sample compartment base
plate. This option is useful for performing polarization studies of
thin films and other sample types.

The polarizer cannot be installed on spectrometers with sample
compartment windows. S
In Spectrometer Help Topics view “Installing optional hardware” for
detailed information about installing the polarizer.
In these experiments, a unique background is required for each
polarization position used. For example, if you are going to collect
spectra at 0 and 90 degrees, corresponding background spectra are
required at 0 and 90 degrees.
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To set the polarization angle, type any number from 0 to 180 in the
Polarizer Angle text box on the Bench tab of the Experiment Setup
dialog box (available through Experiment Setup in the Collect
menu). Use the up and down arrows to step the polarizer one degree
at a time to optimize your signal.

?

In OMNIC Help Topics find “polarizer” in the Index and go to
“Controlling the polarizer” for more detailed instructions.
Begin you experiment by collecting backgrounds (as single beam
spectra) at each polarizer angle required by your experiment. Save
each background spectrum with a unique, descriptive name, such as
Background 0, Background 90. Once the background spectra are
collected and saved, you can begin to collect sample spectra. Sample
data may be collected and saved as single beam spectra. Once data
collection is complete, use the appropriate background file to
reprocess the data into your final format. Sample data also may be
collected and saved as ratioed spectra (%T, A, %R etc.) using the
corresponding stored background. Use the Background Handling
parameter on the Collect tab in Experiment Setup to specify the
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background file name. Click the Use Specified Background File
checkbox and then enter the background spectrum filename.
If you have OMNIC Macros\Basic or OMNIC Macros\Pro, you can
create a macro that changes the angle incrementally with each
successive set of background and sample spectra.
Then use Experiment Setup to specify that the Macro button start the
experiment and run the macro. Use the Macro for Macro button field
on the Advanced tab in Experiment Setup dialog box (available
through Experiment Setup in the Collect menu) to specify the macro
to run. You may browse to locate the macro file or type the full path
and file name into the text field.

If you have OMNIC Series, you can display the series of spectra
collected in this way. To create a series (.SRS) file from your
spectra, follow the instructions in "Creating a series data set" in the
"Series Menu Commands" chapter of the OMNIC Series User's
Guide.
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Accessories
This chapter briefly describes the types of sampling and system
accessories that are available for your spectrometer. Complete
descriptions and operating instructions are included with the
accessories.

Smart Accessories

In addition to traditional accessories, a variety of Smart Accessories
are available for your spectrometer. Nicolet FT-IR spectrometers
identify each Smart Accessory as it is installed and set the software
parameters for data collection. Also, a series of spectral quality
checks are performed to ensure that the accessory is installed and
operating correctly.
Detailed tutorials for installing, operating and maintaining each
Smart Accessory are provided on-line. To start a Smart Accessory
tutorial, click Sampling Techniques in the Help menu and then click
the accessory name.
Smart ARK – This is a horizontal ATR (attenuated total reflection)
accessory with high stability, complete purge capabilities, tool-free
alignment and high performance specifications. It includes integral
purge tubes that seal the accessory from the atmosphere, and a cast
aluminum body for exceptional stability.
Smart Collector – Diffuse reflection enables analysis of highly
light-scattering solids that are difficult to analyze using transmission
techniques. This method is also useful when the sample, usually a
powder, must be analyzed without modification.

Nicolet FT-IR User’s Guide

81

Smart Diffuse Reflectance – The diffuse reflection technique lets
you analyze highly light-scattering solids that are difficult to analyze
using transmission techniques. The technique is also useful when the
sample, usually a powder, must be analyzed without modification.
This accessory lets you analyze a wide variety of sample types and
features integral sample cups for convenient, fast sampling.
Smart DuraSamplIR – This single-reflection horizontal ATR
accessory has a viewing feature that makes it easy to position the
sample and monitor the applied pressure. The accessory is ideal for
small samples and can be used to measure liquids, powders and
pliable solids.
Smart DuraScope – The Smart DuraScope combines the benefits
of a diamond ATR element with video enhancement to create an
analysis tool for a wide range of sample types, from large, hard
materials to small inclusions and contaminants. You can position the
sample while looking through the diamond ATR element. This helps
you manipulate micro samples to achieve optimum contact with the
crystal, resulting in superior quality spectral data.
Smart Endurance – This single-reflection diamond ATR accessory
is rugged and versatile. It stands up to highly corrosive, caustic,
intractable or abrasive samples, making it a good choice for almost
any sample type.
Smart Golden Gate – This is a horizontal, single-reflection ATR
accessory that features an extremely durable diamond crystal. It
handles a wide range of sample types, including hard or brittle
solids, corrosive liquids and hard powders.
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Smart Mid-IR FiberPort – This high-throughput accessory lets you
analyze liquids remotely. The needle probe can reach “hard to get”
samples, such as liquids in micro containers, hazardous
environments or remote locations. The FiberPort is a unique optical
interface that transfers IR energy from the spectrometer to the fiber
optic cables and probes. A complete line of fiber optic probes is
available for sampling a wide range of sample types.
Smart MIRacle – This is a single-reflection horizontal ATR
accessory with exceptional throughput and sensitivity. It can use
several crystal types and has a micrometer screw for precise control
of applied pressure.
Smart Multi-Bounce HATR – This multi-reflection horizontal
ATR accessory has a shorter pathlength and higher throughput than
traditional HATR accessory designs. It is the best choice for routine
analysis of strong infrared-absorbing samples. This accessory is
ideal for rapid quantitative and qualitative analyses, since sample
preparation is usually not necessary.
Smart OMNI-Sampler – This single-reflection ATR accessory
features a spherical crystal that lets you measure a wide variety of
sample types. The unique tower design automatically applies the
optimum pressure while protecting the crystal. The accessory is ideal
for analyzing very small samples or sample areas and provides high
reproducibility.
Smart OMNI-Transmission – This easy-to-install transmission
accessory lets you sample liquids, gases and solids using a wide
variety of transmission cells and infrared cards.
Smart Orbit – This single-reflection ATR accessory features a
durable diamond crystal and a swivel pressure tower that ensures
consistent pressure from sample to sample. You can use the
accessory to perform analyses from the near-IR to the far-IR.
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Smart Performer – This single-reflection ATR accessory features a
horizontal sampling surface for collecting high quality spectra with
minimal sample preparation. The accessory uses a wide variety of
low cost crystals that are easy to install and remove.
Smart Refractor – This is top-loading accessory is designed for
fast analysis of coatings on reflective substrates using the grazing
angle specular reflection technique.
Smart SAGA – This advanced accessory is designed for the
analysis of thin films on reflective substrates. The 80 degree angle of
incidence for this reflection-absorption accessory allows sensitive
measurements of films as thin as 0.1 nm.
Smart SpeculATR – This single-bounce horizontal ATR/specular
reflection accessory allows versatility in measurement where a range
of sample morphologies may need to be analyzed.
Smart SplitPea – This horizontal ATR microsampling accessory is
designed for fast analysis of solids, liquids, and powders. It is ideal
for analyzing hard materials, small samples or samples where only
minute quantities are available.
?
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In OMNIC Help Topics find “accessory” in the Index and go to
“Specifying the accessory” for instructions for setting up and saving
experiments for custom accessories.
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Other sampling
accessories for
different applications

You can install many of the sampling accessories yourself. After you
install an accessory, you may have to align it. Instructions for
aligning the spectrometer are included in the “Maintenance and
Service” chapter of this manual. Instructions for aligning an
accessory are provided in the documentation that came with that
accessory.
Some accessories fit into the sample compartment and require that
you remove the Snap-In baseplate before installing the accessory.
For information about using Snap-In baseplates, view “Removing
the Snap-In baseplate” in the “Setting up experiments” book in
Spectrometer Help Topics.

Note

Additional Snap-In sample compartment baseplates are available for
use with each accessory to make changing accessories easier. S
Call Thermo Electron if you are interested in ordering any of the
following sampling accessories.
Absolute transmission accessory – This accessory allows for the
measurement of absolute transmission of samples with reflective
surfaces. The design prevents energy reflected from the sample from
entering the interferometer for remodulation. Using this accessory
involves replacing pinned-in-place mirrors before and after the
sample compartment.
Automatic sample wheel – This accessory holds multiple samples
and rotates them into the beam path for data collection. The sample
wheel is commonly used to measure multiple polymer or pressedpowder samples automatically.
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Auxiliary experiment module (AEM) – The AEM provides you
with an additional sample compartment. You can position it on the
right or left side of the spectrometer. With an AEM installed, you
can run routine analyses with the spectrometer and quickly switch
beam paths to the AEM to collect data from other samples without
removing accessories from the main sample compartment. Any
accessory or detector that can be installed in the spectrometer can be
installed in the AEM. The AEM has two detector locations.
Custom accessory baseplate – You can use this Smart baseplate to
mount an accessory you have built or purchased from another
manufacturer. When you install the accessory and baseplate in the
sample compartment, the system automatically selects the Custom
Accessory experiment (or allows you to select from the experiments
you have saved for the baseplate).
Detector interface kit – A variety of accessories (that were
specifically designed for Nicolet FT-IR spectrometers) contain
detectors that are automatically recognized by your spectrometer.
The detector interface kit allows your spectrometer and OMNIC
software to recognize other detectors, including non-Thermo
Electron detectors.
Energy screen wheel – This accessory lets you prevent detector
saturation and signal distortion by using a screen to block a portion
of the infrared energy. See “Using the energy screen wheel” in the
“Spectrometer Options” chapter for complete information.
Filter wheel – This accessory (available for the Nicolet 6700 only)
lets you control the spectral range of the infrared light that reaches
the detector by inserting low pass or high pass filter into the beam
path. See “Using the filter wheel” in the “Spectrometer Options”
chapter for complete information.
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Foundation Series – The innovative modular design of this
accessory family provides access to several sampling devices using a
common base. This allows experimental flexibility and an
economical price. Available techniques include ATR, diffuse
reflection, specular reflection, transmission and fiber optics.
Gas cells – A variety of short- and long-pathlength gas cells are
available. Cells include built-in transfer optics that fit into your
spectrometer. The cells are suitable for use in both ambient and
elevated temperature conditions. Gas cell heating, transfer optics
purge, gas manifold, and sample window options are available to
accommodate a variety of sample gases and sampling conditions.
GC interface – This interface attaches to the right side of the
spectrometer and must be connected to a gas chromatograph (GC).
You can then analyze IR spectra from GC experiments using the
OMNIC Series software.
Liquid Analysis System – This system lets you collect and process
quantitative analysis data for liquid samples. It uses OMNIC Integra
software, which contains methods for quantifying components in
specific types of liquids.
Microplate accessory – This accessory allows you to collect
transmission or diffuse reflectance spectra of multiple solid or liquid
samples consecutively. All the samples are loaded into the sample
chamber at one time into a 96 or 384 well microtiter plate. The
ejection, insertion, and movement of the well plate inside the sample
compartment is controlled by software.
Near-IR Heated Cuvette Holder E.S.P. – This accessory is
designed for analyzing samples that require a constant or elevated
temperature to obtain reproducible near-IR results. You can use it to
analyze liquids, gels and solids that have a low melting point, such
as waxes.
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Nicolet Centaurµs and Nicolet Continuµm infrared microscopes
– Thermo Electron offers microscopes that attach directly to the side
of the spectrometer. Microscopes can be installed between the
spectrometer and other accessory modules. The microscopes provide
fast, nondestructive microanalysis with minimal sample preparation
and alignment.
PAC 300 Photoacoustic E.S.P. – Photoacoustic spectroscopy (PAS)
is a powerful technique for the nondestructive spectroscopic analysis
of solid samples of all types. PAS is particularly applicable to
powders (including dark, highly absorbent samples), polymer
pellets, beads, and sheets and films. The PAC 300 Photoacoustic
E.S.P. accessory is fully integrated with the spectrometer and
computer. It automatically selects an OMNIC experiment, draws
power right from the spectrometer and includes an on-line tutorial.
Polarizer – This accessory lets you control the orientation of the
electric field vector of the infrared beam as it enters the sample
compartment. This is particularly useful for characterization of
monolayers, thin films and other sample types. See “Using the
polarizer” in the “Spectrometer Options” chapter for more
information.
Remote Start accessory – This accessory adds external trigger
capability to your spectrometer. With a press of the Start switch, you
can control the start of data collection or coordinate the start of an
external experiment.
SabIR – This accessory provides remote sampling capability for
raw material identification, quality measurements, and sample
component analysis. The system is optimized for diffuse-reflectance
sampling of solids and powders. Materials may be sampled directly
or indirectly through packaging materials.
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Sample shuttle – A sample shuttle lets you collect background
spectra without removing the sample from the sample compartment.
The shuttle automatically moves the sample out of the beam path
before background collection begins. Since the sample compartment
cover is not opened, the system purge is maintained.
Specular reflection accessories – Specular reflection provides a
nondestructive method for measuring surface coatings without
sample preparation. Specular reflection accessories can be used to
analyze surface-treated metals, paints, semiconductors, and resin and
polymer coatings.
TGA interface/TGA module – This interface is equipped with a
built-in, temperature-controlled flow cell and must be connected to a
thermogravimetric analysis (TGA) furnace. You can analyze the
evolved gases from TGA experiments using the OMNIC Series
software. The TGA interface is usually mounted in the sample
compartment of an AEM; the TGA module is usually installed on
the side of the spectrometer, leaving the AEM or spectrometer
sample compartment free for other experiments and accessories.
Transmission E.S.P. accessory – Transmission is the oldest and
most efficient sampling technique in FT-IR spectroscopy and can be
used for sampling liquids, gases or solids. A variety of cells and
sample holders are available for transmission analysis. All can be
mounted in the spectrometer sample compartment. Thermo
Electron’s E.S.P. (Enhanced Synchronization Protocol) technology
provides continuous communication between the accessory and
OMNIC to ensure that the accessory is operating correctly. This
accessory, or the validation wheel (described below), is required for
using an NPL or serialized polystyrene standard for validation with
Thermo Electron’s Val-Q software.
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Validation wheel – The validation wheel is used with Val-Q to
validate the performance of the spectrometer. The wheel
automatically moves standard samples into the beam path at the
appropriate times during the validation procedure. The samples are
traceable to standards from the National Institute of Standards and
Technology (NIST). An optional calibrated sample from the
National Physical Laboratory (NPL) is also available.

System accessories

Some system accessories are installed by Thermo Electron. Call us if
you are interested in ordering any of the following accessories.
Power line conditioner – Power line conditioners protect your
spectrometer and other accessories from damage or malfunction due
to voltage dropouts, transient spikes, frequency shifts or other
disturbances in your electrical service.
Pure air dryer – If you have difficulty controlling moisture in your
laboratory, the pure air dryer provides additional protection for the
hygroscopic elements of your spectrometer. This accessory is also
useful if your laboratory air supply is contaminated with volatile
solvents, oil or other reactive materials.
Purge gas generator – If you do not have in-house facilities to
supply compressed air or nitrogen for system purge, Thermo
Electron offers several purge gas generators.
RSVP (Remote Support and Verification Program) – This
diagnostics option uses a data modem and remote control software to
allow control of your computer (and spectrometer) through the
modem link. An analog telephone line is required.
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Smart Purge Kit – This kit adds enhanced purging capability to
your spectrometer. When you open the sample compartment cover
or its sliding door, Smart Purge automatically increases the purge
gas flow rate for a short time. This keeps water vapor, carbon
dioxide and other unwanted gases out of the spectrometer while you
install or remove a sample. You can then collect spectra without
waiting for proper purge to be restored.
Uninterruptable power supply – An uninterruptable power supply
reduces the chance of a system shutdown if power is lost.

How to cable
an accessory

Pass-through connectors

Caution

When you install an accessory in the sample compartment, you may
need to connect one or more cables from the accessory to connectors
on the rear wall of the compartment. You may also need to attach
cables from other peripherals (such as computers, custom controllers
or power supplies) to the accessory or from the accessory to the
connectors on the front of the spectrometer. The instructions that came
with the accessory contain specific information about connecting that
accessory.

Your spectrometer may be equipped with pass-through connectors
for use with special accessories. These connectors allow you to make
accessory cable connections through the spectrometer. This
eliminates the need to run cables through the seal on the sample
compartment cover or out the top of the sample compartment.
Improper or unsafe cabling can cause damage to your accessory and
create a safety hazard. Only qualified persons should cable a custom
accessory using these connectors. Thermo Electron is not
responsible for damage or injury resulting from improper or unsafe
cabling. S
To use the pass-through connectors, connect the accessory inside the
sample compartment and connect the external power or
communications peripheral to the corresponding pass-through
connector on the front of the spectrometer.
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Connectors inside
the sample compartment

The following illustration shows the locations of the electrical
connectors inside the sample compartment:

Accessory connector for detector
signal or accessory control and power

Detector/Motors

Auxiliary
Purge
Out

Optional pass-through connector
for communication or other signal

Detector/Motors – If you have a photoacoustic or other accessory
that has a detector or motor located in the spectrometer sample
compartment, connect the cable from the detector or motor to this
standard connector. This is not a pass-through connector. See
“Detector/Motors connector” for information about using this
connector to connect custom hardware.
Auxiliary – Six pins on this optional connector can be used for
passing DC power input or other signals from the Auxiliary 1 and
Auxiliary 2 connectors on the front panel to an accessory. For
example, the automatic sample wheel and the ProfilIR accessory get
DC power through this connector when the DC power output of an
AC-to-DC converter is attached to the Auxiliary 1 connector on the
front panel. See “Using connectors for custom accessories” for
information about which pins are available for use.
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Connectors on the
front of the spectrometer

Note

The illustration below shows the optional connectors on the front of
the spectrometer that you can use to pass signals to and from the
sample compartment.

These connectors are available only on systems that do not include
the SabIR accessory or the microplate accessory. S
Auxiliary 1 – This connector passes power or other signals for the
accessory to three pins on the Auxiliary connector inside the sample
compartment. This connector could be used, for example, to attach
the DC output of an AC-to-DC converter to provide DC power to an
accessory in the sample compartment.
Auxiliary 2 – This connector passes signals to three pins on the
Auxiliary connector inside the sample compartment. This connector
could be used, for example, to allow an accessory in the sample
compartment to be controlled through your computer’s serial
(RS-232C) port.

See the next section for information about which pins are available
for use.
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Using the pass-through
connectors for
custom accessories

By connecting custom cables that use the pins on the pass-through
connectors, you can provide power and communication or other
signals for your custom accessories. The power and signals pass
through the spectrometer from the front to the sample compartment
and vice versa. Make sure your use of the connectors complies with
the voltage and current limitations given in the following Warning.

Warning

Improper or unsafe cabling can cause damage to your accessory and
may create a safety hazard. Only qualified persons should cable a
custom accessory using these connectors. Do not pass signals that
exceed ±15 VDC through these connectors. You must also limit the
current to a maximum of 800 mA. Thermo Electron is not
responsible for damage or injury resulting from improper or unsafe
cabling. S
The following diagram shows schematically which pins of the
Auxiliary connector inside the sample compartment are connected
internally to pins of the Auxiliary 1 and Auxiliary 2 connectors on
the front of the spectrometer. Since none of these connected pins are
assigned by the Nicolet 4700 or Nicolet 6700, they are available for
use with custom accessories.

Sample Compartment
Connector

Front Panel
Connectors

1

2

3

7

6

4

8

9

1
8

7

6

5

4

3

2

5

(male)

1

Auxiliary
15

14

13

12

11

10

9

2
5

4

9
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3

8

(female)
2

7

1

6

Detector/Motors
connector

You can use the Detector/Motors connector on the rear wall of the
sample compartment to connect your own detectors, accessory
motors and other custom hardware.

8

7

15

14

6

5

13

4

12

3

11

2

10

1

9

Detector/Motors

Make sure your use of the connector complies with the voltage and
current limitations given in the following Warning.
Caution

Improper or unsafe cabling can cause damage to your accessory and
may create a safety hazard. Only qualified persons should connect a
cable to the Detector/Motors connector. Do not use this connector
for signals that exceed ±15 VDC. Limit the current to a maximum of
800 mA. Thermo Electron is not responsible for damage or injury
resulting from improper or unsafe cabling. S
The following table shows “pinout” information for the
Detector/Motors connector. Use this information when designing a
cable to connect your custom hardware to the connector. Refer to the
preceding illustration for the locations of the numbered pins.
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Pin Number
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Description

1

Do not use this pin.

2

Used by the sample shuttle motor (negative).

3

Positive 5 volts.

4

Analog ground.

5

Used by the sample compartment detector for
negative analog input.

6

Positive 12 volts analog.

7

Used by the sample compartment detector for digital
communication.

8

Positive 5 volts.

9

Used for sample compartment digital communication.

10

Used by the sample shuttle motor (positive).

11

Positive 12 volts.

12

Analog ground.

13

Used by the sample compartment detector for positive
analog input.

14

Negative 12 volts analog.

15

Used by the sample compartment detector for digital
communication.

Quick Answers to Your Questions
About Using OMNIC
This chapter answers some common questions about using OMNIC.
Each answer is followed by a reference telling you where to go for
more information.
Where a menu command name is given, the corresponding toolbar
button is also shown. Depending on the software configuration you
are using, a particular button may not be present in your toolbar.

Collecting spectra

How do I set the software for collecting spectra?
You can set the software in one step by selecting a stored experiment
from the Experiment drop-down list box below the OMNIC window
menu bar. To set the experiment parameters individually, use
Experiment Setup in the Collect menu.
If you install a Smart Accessory, the system automatically sets the
software parameters (or a list of appropriate experiments is made
available for your selection), and you can begin collecting spectra.
Collecting a Spectrum (available through Learning OMNIC)...
“Preparing the Software”

?

In OMNIC Help Topics find “experiment” in the Index and go to
“Selecting an experiment” or “Using Experiment Setup.”
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How do I collect a spectrum?
First set the parameters as explained above. Depending on the
settings, you may need to install or remove the sample before
collecting data. Then press the Sample button on top of the
spectrometer, or choose Collect Sample from the Collect menu.
Collecting a Spectrum (available through Learning OMNIC)...
“Collecting the Spectrum of a Sample”
?

In OMNIC Help Topics find “spectrum” in the Index and go to
“Collecting a sample spectrum” or “Collecting a background
spectrum.”

How do I specify the Y-axis unit for collecting spectra?
Choose Experiment Setup from Collect menu and then set Final
Format on the Collect tab.
You can change the format of a collected spectrum by using
Absorbance, % Transmittance or Other Conversions in the Process
menu. See the question and answer in the next section for a
description of the available units.
Collecting a Spectrum (available through Learning OMNIC)...
“Typical IR Transmission Spectrum”
?
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“Selecting the final format.”
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What does gain do?
Gain amplifies the detector signal intensity, making it larger relative
to the level of electronic noise. This is helpful when the signal is
weak, such as when you use some sampling accessories. You can let
OMNIC automatically adjust the gain to maximize the signal by
setting the Gain parameter to Autogain. We recommend using this
setting to ensure the best spectral quality.
?

In OMNIC Help Topics find “gain” in the Index and go to “Setting
the gain.”

When should I save interferograms with my spectra?
Save interferograms if you think you may want to restore the
original data after it has been processed or if you want to keep an
archive of your original data.
Collecting a Spectrum (available through Learning OMNIC)...
“Preparing the Software”
?

In OMNIC Help Topics find “saving, interferograms” in the Index
and go to “File handling.”

What does the Collect Sample window show?
The window displays the “live” spectrum as it is being collected plus
a gauge indicating the progress of the collection, an indicator
showing whether any problems have occurred and other information
about the collection.
Collecting a Spectrum (available through Learning OMNIC)...
“Collecting the Spectrum of a Sample”
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?

In OMNIC Help Topics find “spectrum” in the Index and go to
“Collecting a sample spectrum.”

How do I know my spectra are meeting quality
standards?
OMNIC continuously monitors the quality of the data you collect,
based on the parameters you set. The Quality tab in the Experiment
Setup dialog box contains parameters for specifying the spectral
quality characteristics that you want checked when you collect
spectra.
OMNIC offers four categories of spectral quality checks:

•
•
•
•

Spectrum checks
Parameter checks
Background checks
Interferogram checks

When OMNIC performs a check and detects a problem, the Collect
Status indicator is displayed as a yellow circle or a red X. Click the
indicator (or click the View Collect Status button at the end of data
collection) to see a summary of data collection problems
encountered during the collection and other information about the
collection.
When a collected spectrum passes all of the selected quality checks,
the Collect Status indicator appears as a green check mark.
?
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Converting
spectra to other units

Which Y-axis unit should I use for a spectrum?

The most commonly used units are % transmittance and absorbance.
Use % transmittance if you plan to compare the spectrum visually
with published reference spectra. Use absorbance units for
quantitative analysis measurements.
Kubelka-Munk units are useful for searching diffuse reflectance
spectra against libraries of absorbance spectra.
Use photoacoustic units for spectra collected using a photoacoustic
accessory.
Percent reflectance units are mathematically equivalent to
% transmittance units, but using them for spectra collected using a
reflection technique serves to identify the technique.
Using log (1/R) units for spectra collected using a reflection
technique is useful for quantitative comparisons, since there is often
a linear relationship between the concentration of a component and
its log (1/R) value.
Collecting a Spectrum (available through Learning OMNIC)...
“Typical IR Transmission Spectrum”

?

In the OMNIC Help Topics Index...
Find “absorbance” and go to “Converting spectra to absorbance.”
Find “transmittance (%)” and go to “Converting spectra to
% transmittance.”
Find “Kubelka-Munk units” and go to “Kubelka-Munk units.”
Find “photoacoustic units” and go to “Photoacoustic units” topic.
Find “reflectance (%)” and go to “% Reflectance units.”
Find “log (1/R) units” and go to “Log (1/R) units.”
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Using
spectral libraries

?

How do I search a spectral library?
First prepare the spectrum (as explained below) and display or select
the region you want searched. Then set up the search using Library
Setup in the Analyze menu and start the search by clicking the
Search button in the Library Setup dialog box or by choosing Search
from the Analyze menu.
In OMNIC Help Topics find “library” in the Index and go to
“Setting up a library search” or “Searching a spectral library.”

How should I prepare my spectrum before searching it
against a spectral library?
There are several corrections you can perform on a spectrum to
obtain the best search results:

• If the baseline of the spectrum is sloped, curved or shifted
vertically, correct it using Baseline Correct in the Process menu.
?

In OMNIC Help Topics find “baseline” in the Index and go to
“Correcting a baseline manually.”

• If the spectrum has totally absorbing bands, eliminate them by
using Blank in the Process menu. Be careful not to blank regions
that contain other important spectral information.
?

In OMNIC Help Topics find “blanking spectral region” in the
Index and go to “Blanking a spectral region.”
You can also use the region tool to select a region of the
spectrum that does not include any totally absorbing bands or use
the view finder to display the region before searching. (These
methods avoid the loss of spectral information that results from
blanking.)
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?

In OMNIC Help Topics find “spectral region” in the Index and
go to “Region tool” or “View finder.”

• If you collected the spectrum using specular or diffuse reflection,
use Kramers-Kronig (dispersion) correction (available through
Other Corrections in the Process menu) to correct it for
dispersion effects and then search it against a library of
absorbance spectra.
?

In OMNIC Help Topics find “Kramers-Kronig transformation”
in the Index and go to “Kramers-Kronig (dispersion)
transformation.”

• If you collected the spectrum using ATR (attenuated total
reflection), use ATR correction (available through Other
Corrections in the Process menu) to correct it for variation in the
depth of penetration and then search it against a library of
transmission spectra.
?

In OMNIC Help Topics find “ATR correction” in the Index and
go to “ATR correction.”

• If the spectrum has water or carbon dioxide peaks, use Other
Corrections to remove these peaks.
?

In OMNIC Help Topics find “water” in the Index and go to
“H2O and CO2 correction.”
Only those portions of the spectrum which are within the selected
region (or displayed region if no region is selected) and within any
of the regions you specified for the library using the Region Setup
tab of the Library Setup dialog box will be included in the search. If
the spectral range of the spectrum is broader than that of the library
spectra, use the region tool to select the region of the spectrum that
coincides with the library spectra before you start the search. You
can also use the view finder to display the region to search. The
Search command operates on the selected region, or on the displayed
region if a region is not selected.
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?

In OMNIC Help Topics find “spectral region” in the Index and go to
“Region tool” or “View finder.”

How do I create a spectral library?
If you are using OMNIC, use the Create Library button on the
Library Names tab of Library Manager (available through the
Analyze menu) to create a user library.
Once a library is created, you can add spectra to it with Add To
Library in the Analyze menu or by dragging the spectrum to the
library’s book on the Library Names tab of Library Manager. You
can use a search library you create just as you would a commercial
library to identify unknown spectra. You can use a QC library to
verify the composition of a sample. If you create a scrapbook library,
you can find spectra in it by searching for text (but not by spectral
searching).
When you create a library, you determine the kinds of information
that will be saved with it.
?

In OMNIC Help Topics find “library” in the Index and go to
“Creating a user library” and “Adding spectra to a user library.”

How can I display a library spectrum in a spectral
window?
If you are using OMNIC, locate and select the spectrum in Library
Manager (available through the Analyze menu) and then click the
Add To Window button, or go to the Library Spectra tab of Library
Manager, display the desired spectrum on the tab and then doubleclick the spectrum.
?
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“Working with libraries.”
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How can I find a compound in a commercial library?
If you are using OMNIC, Library Manager in the Analyze menu lets
you search for the compound name. After you select the library on
the Library Names tab, use the features on the Search For Text tab to
locate the spectrum. Type the text to search for in the Text In
Selected Item box, and then choose Search. The search results
appear in the table based on the options you have set. To see
information about a found spectrum, double-click its row in the
table.
?

In OMNIC Help Topics find “library” in the Index and go to
“Searching a library for text.”
You can use the extended search feature (available on the Extended
Search tab of the Library Setup dialog box) to find library spectra by
searching for text in any field included in the library. For example,
some libraries have fields for molecular weight, boiling point or
manufacturer.

?

In OMNIC Help Topics find “extended search” in the Index and go
to “Using extended search.”

What is the easiest way to collect sample spectra and
add them to a spectral library?
If you are using OMNIC, use the Collect Spectrum button on the
Library Names tab of Library Manager (available through the
Analyze menu) to collect a spectrum and add it to a user library. The
software automatically sets the experiment parameters (for example,
Resolution) so that the spectrum will be compatible with the selected
library. This allows you to collect and add a compatible spectrum in
one step instead of three (using Experiment Setup to set the
parameters, Collect Sample to collect the spectrum and Add To
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Library to add the spectrum to the library).

What does the search expert do?
It determines the search algorithm to use, searches the spectral
region from 2600 to 450 wavenumbers and then displays the
specified number of library spectra that best match the unknown
spectrum, plus comments about the search results. For example, the
search expert may tell you that the best match is excellent but the
second best match is also similar to the unknown. You will be able
to display the list of matches to see their match values and index
numbers.

Opening, saving
and deleting spectra

?

How do I open a stored spectrum?
Choose Open from the File menu, locate the spectrum or spectra you
want to open, select the filenames of the spectra and then choose
OK. You can hold down the Control key to select multiple files.
In OMNIC Help Topics find “spectrum” in the Index and go to
“Opening spectra.”

How can I save my collected spectra automatically?
Choose Experiment Setup from the Collect menu and turn on Save
Automatically on the Collect tab (Save Automatically is on by
default). Specify a base name for naming the saved spectral data
files in the Base Name box. A sequential number will be appended
to the base name when the spectra are saved. If you want the
interferograms saved with the spectra, turn on Save Interferograms.
Individual spectra are saved with the extension .SPA.
Collecting a Spectrum (available through Learning OMNIC)...
“Preparing the Software”
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?

In OMNIC Help Topics find “saving, spectra” in the Index and go to
“File handling.”

Where should I save my spectra?
You have several options for saving spectra; you may choose to use
more than one.
For a permanent record of the spectrum and any other information
you want to record, use a report notebook.
?

In OMNIC Help Topics find “report notebook” in the Index and go
to “Adding a report to a notebook.”
You can also place spectra in descriptively named user libraries that
you create. Keeping spectra in libraries allows you to find them by
searching for text contained in the information saved with the
spectra.

?

Note

In OMNIC Help Topics find “spectrum” in the Index and go to
“Adding a spectrum to a user library.”
When you add a spectrum to user library whose resolution is lower,
the spectrum is deresolved. For this reason it may be better in some
cases to save your sample spectra as files on the hard disk and
consider the copies of them added to a user library to be for
searching purposes only. S
We recommend that you create descriptively named folders
(directories) on your hard disk for different categories of spectra. For
example, you could have a folder for each project you are working
on, for each of your clients, for each laboratory application, or for
each sample type. See your Windows documentation for information
about creating directories. You can specify which folder to use when
you use Save or Save As in the File menu to save spectra. This will
make it easier to find a spectrum in a particular category when you
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use Open in the File menu to open a spectrum.

?

In OMNIC Help Topics find “spectrum” in the Index and go to
“Saving spectra using new filenames.”

How can I save several spectra in one file as a group?
Select the spectra and then choose Save Group from the File menu.
To select more than one spectra, hold down the Control key and
click each spectrum you want to select with the selection tool, and
then release the Control key. Spectral groups are saved with the
extension .SPG.
?

In OMNIC Help Topics find “saving, spectra” in the Index and go to
“Saving a group of spectra.”

How can I delete stored spectra?
Choose Delete Files from the File menu to display the Delete Files
dialog box. Locate and select the spectral data files (with the
extension .SPA, or .SPG for spectral group files) you want to delete
and then choose OK.
?
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to delete files.”
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Can I delete an entry from a report notebook?
No. OMNIC’s report notebooks are similar to traditional laboratory
notebooks in that information you add to them becomes part of the
permanent record of your work.
You can delete an entire notebook, however, by deleting the entire
notebook file. Choose Delete Files from the File menu to display the
Delete Files dialog box. Locate and select the directory containing
the notebook data files (with the extension .NBK). You will have to
set the List Files Of Type box to All (*.*) to see .NBK files listed.
Select the file you want to delete and then choose OK.

Printing

How can I specify a printer for printing information?
Use Printer Setup in the File menu. See your Windows
documentation for details on setting the printer parameters.

?

In OMNIC Help Topics find “printer” in the Index and go to
“Setting up the printer.”

How can I create and print reports of my work?
Use the commands in the Report menu. First use Template to select,
edit or create a template for the report. Then use Preview/Print
Report to view the report as it will appear on paper. Click the Print
button to print the report.
View Creating Reports (available through Learning OMNIC) to
learn about OMNIC’s report features.
?

In OMNIC Help Topics find “template” in the Index and go to
“Selecting, editing or creating a report template,” or find “report,
previewing or printing” and go to “Previewing or printing a report.”

Nicolet FT-IR User’s Guide

109

You can also use Add To Notebook to add the report to a report
notebook. You can then print the report with the Print button when
you view the notebook using View Notebook.
?

In OMNIC Help Topics find “report” in the Index and go to “Adding
a report to a notebook.”

How can I preview spectra or other information before
printing?
Use Preview/Print Report in the Report menu to view a report as it
would appear on paper. The report is displayed using the current
report template; that is, the template you specified with Template or
the one you are viewing and working with. If the report is displayed
as you want it to appear on paper, you can print it by using the Print
button.
?

Displaying spectra

In OMNIC Help Topics find “template” in the Index and go to
“Selecting, editing or creating a report template,” or find “report,
previewing or printing” and go to “Previewing or printing a report.”

How can I select more than one spectrum at a time?
After selecting the first spectrum by clicking it, hold down the
Control key while you click each additional spectrum. You can also
choose Select All from the Edit menu to select all the spectra in the
window that are not hidden.

?
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In OMNIC Help Topics find “spectra” in the Index and go to
“Selection tool” or “Selecting all the spectra in a spectral window.”
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How can I specify colors for displaying spectra?
Choose Options from the Edit menu, click the View tab and then
choose Colors. In the Colors dialog box click the color next to the
spectrum number for which you want to specify the color and then
click the desired color in the color array. To specify the color for
selected spectra, click the color next to Selected Spectrum and then
click a color. Typically red is the color reserved for displaying
selected spectra.
?

In OMNIC Help Topics find “spectra” in the Index and go to
“Specifying colors for spectra and other features.”
You can also specify colors for displaying spectra in a particular
spectral window. Start by selecting the spectra for which you want to
specify a color, and then choose Display Setup from the View menu.
Click the desired color in the color array and then choose OK. When
the spectra are no longer selected, such as after you select a different
spectrum, they will be displayed in the color you clicked.

?

In OMNIC Help Topics find “spectra” in the Index and go to
“Selecting a color for the currently selected spectra.”

What is the difference between the Display Setup
parameters and the Window options?
The parameters in the Display Setup dialog box affect the currently
active spectral window only. The options in the Window options (in
the Options dialog box, available through the Edit menu) affect all
the new spectral windows that you create. After you create a new
spectral window, you can change the way spectra are displayed in it
by using Display Setup in the View menu.
?

In OMNIC Help Topics find “display parameters” in the Index and
go to “Setting the display parameters,” or find “Window options”
and go to “Window options.”
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What can I do with the “Scale” commands in the View
menu?
By using the appropriate command, you can display spectra so that
they are easier to see or compare.
Full Scale displays the spectra so that they perfectly fit their panes
vertically. Automatic Full Scale does this automatically when you
change the display with the view finder or selection tool. The Y-axis
displayed corresponds to the selected spectrum.
Common Scale displays all the spectra so that they are not cut off at
the top or bottom and use the same Y scale. This allows you to
compare the band intensities of different spectra.
Match Scale changes the Y scale of the spectra to be the same as that
of the selected spectrum. (The selected spectrum’s scale is not
changed.) This allows you to compare the band intensities of
different spectra.
Offset Scale shifts the spectra vertically so that they overlap less,
making them easier to see.
When you use these commands, keep in mind that the current Y-axis
is always accurate for the currently selected spectrum but may not
apply to other spectra in the window.
?

In the OMNIC Help Topics Index...
For information about Full Scale or Automatic Full Scale, find
“spectra” and go to “Displaying spectra full scale” or
“Displaying spectra full scale automatically.”
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For information about Common Scale, find “spectra” and go to
“Displaying spectra using the same Y-axis.”
For information about Match Scale, find “spectra” and go to
“Matching the Y scale of a spectrum.”
For information about Offset Scale, find “spectra” and go to
“Displaying spectra vertically offset.”

How can I zoom in on an area of a spectrum?
Draw a box around the area using the selection tool and then click
inside the box.
You can also use the Expand/Contract buttons at the left end of the
view finder or drag the regions markers in the view finder to display
a smaller spectral region. You can press and hold down the mouse
button during these operations to continuously expand or contract
the display.
To expand and contract the spectra horizontally about the center, use
the view finder's Horizontal Expand/Contract buttons (left-most).
To expand and contract the spectra vertically about the center, use
the Vertical Expand/Contract buttons (right-most).
?

The Roll/Zoom Window in the View menu also expands or contracts
an area. In OMNIC Help Topics find “Roll/Zoom Window
command” in the Index and go to “Rolling and zooming spectra” for
more information about expanding and contracting a spectral region.
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How can I move a spectrum up or down in its pane to
see it better?
Use the selection tool to drag the spectrum up or down. The
Roll/Zoom window available in the View menu to move a spectrum
up or down.
?

In OMNIC Help Topics find “Roll/Zoom Window command” in the
Index and go to “Rolling and zooming spectra” for more information
about moving spectrum.

How can I move a spectrum into another spectral
window?
Use the selection tool to drag the spectrum from one spectral
window to another. A copy of the spectrum appears in the second
window, and the original spectrum remains in the first window. You
can also copy or cut the spectrum using Copy or Cut in the Edit
menu and then paste it into another spectral window using Paste.
?

In OMNIC Help Topics find “spectrum” in the Index and go to
“Selection tool,” or find “pasting, spectrum” and go to “Pasting
items.”

How can I move a stacked spectrum into another pane?
Use the selection tool to drag the spectrum from one pane into
another.
?
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In OMNIC Help Topics find “spectrum” in the Index and go to
“Selection tool.”
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How can I find the X and Y values of a point in a
spectrum?
Use the spectral cursor tool to click the point. The values are
displayed in the readout above the palette.
?

In OMNIC Help Topics find “X and Y values” in the Index and go
to “Spectral cursor tool.”

How can I find the height of a peak?
Use the peak height tool to click the top of the peak. Then drag the
baseline handles to adjust the baseline used for the measurement.
The corrected (measured above the baseline) and uncorrected height
values appear in the readout above the palette.
?

In OMNIC Help Topics find “peak” in the Index and go to “Peak
height tool.”

How can I find the area of a peak?
Use the peak area tool to drag across the peak. Then drag the
baseline handles to adjust the baseline used for the measurement.
The corrected (measured above the baseline) and uncorrected area
values appear in the readout above the palette.
?

In OMNIC Help Topics find “area” in the Index and go to “Peak
area tool.”
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Correcting spectra

Should I correct the baseline of my spectrum?
If a baseline is sloped or curved or significantly above zero
absorbance (or below 100% transmittance), a likely cause is how the
sample was prepared. By correcting the baseline, you can often
avoid having to prepare the sample again and collect a new
spectrum.
Correcting a baseline will give you better results when you search
the spectrum against a library, subtract the spectrum from another
spectrum, find peaks in the spectrum or quantify components in the
spectrum.
Collecting a Spectrum (available through Learning OMNIC)...
“Common Problems with IR Spectra”

?

Subtracting,
adding, multiplying
and dividing spectra

In OMNIC Help Topics find “baseline” in the Index and go to
“Correcting a baseline manually.”

How can I subtract a spectrum from another
spectrum?
Use Subtract in the Process menu whenever you want to subtract one
spectrum from another. Subtract is commonly used to remove
spectral features of solvent residues or pure components from the
spectrum of a mixture of compounds.
Select the spectrum from which you want to subtract spectral
features; this is the sample spectrum. Then hold down the Control
key and select the spectrum with the features you want to subtract
from the sample spectrum; this is the reference spectrum.

Note
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Subtract is available only when two spectra are selected. S
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Choose Subtract from the Process menu. The difference spectrum is
displayed full scale in the bottom pane. This spectrum is the result of
subtracting the reference spectrum from the sample spectrum using the
subtraction factor shown to the left of the result. If you are not
satisfied with the subtraction result, you can change the subtraction
factor.
?

In OMNIC Help Topics find “spectrum” in the Index and go to
“Subtracting spectra.”

What should I use subtraction for?
Subtract is commonly used to remove spectral features of solvent
residues or pure components from the spectrum of a mixture of
compounds. When you use Subtract, the software calculates data
point by data point the difference between the two.
Spectral subtraction is useful in a variety of situations, for example...

• Eliminating solvent peaks in a spectrum of a sample that is
dissolved in a solvent.

• Separating components from a sample that is a mixture of two or
more components.

• Identifying an unknown contaminant by subtracting out the
known sample material.

• Ensuring quality by subtracting an original batch sample
spectrum from a spectrum from the next batch.
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What other mathematical operations can I perform on
my spectra?
You can manipulate spectra using any of the common math
operations. Use Spectral Math in the Process menu to perform these
operations on one or two selected spectra. You specify the
operations to perform by typing a sequence of mathematical symbols
and numbers. The software performs the operations on the Y values
of the data points in the spectrum or spectra and then displays the
result spectrum.
When you choose the command, the Spectral Math window appears
allowing you to type the desired operations in the Operation text
box. You can also select one of the example operations provided in
the Operation drop-down list box.
View Using Spectral Math (available through Learning OMNIC).

?
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In OMNIC Help Topics find “spectrum” in the Index and go to
“Performing arithmetic operations on spectra.”
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Customizing OMNIC

How can I customize my OMNIC software?
You can use Options in the Edit menu to set options that determine
how the software operates. You can also customize the menus and
the toolbar using Edit Menu and Edit Toolbar in the Edit menu. Use
Save Configuration As in the File menu to save your customized
settings in a configuration file. You can then open the file later to
reset OMNIC to your preferences in one step.
Collecting a Spectrum (available through Learning OMNIC)...
“Preparing the Software”

?

In the OMNIC Help Topics Index...
Find “options” and go to “Customizing OMNIC by setting
options.”
Find “menu” and go to “Customizing a menu.”
Find “toolbar” and go to “Customizing a toolbar.”
Find “configuration” and go to “Saving a configuration.”
Find “configuration” and go to “Opening a configuration.”

Nicolet FT-IR User’s Guide

119

Other questions

How can I find and label peaks in spectra?
Use Find Peaks in the Analyze menu to find and label peaks above a
specified threshold.
You can also use the annotation tool to label individual peaks.

?

In OMNIC Help Topics find “peaks” in the Index and go to “Finding
peaks above a specified height,” or find “label” and go to
“Annotation tool.”

How can I close a task window (such as the Find Peaks
window)?
Click the Close button (if available) in the upper-right corner of the
window. You can also double-click the button at the left end of the
window’s title bar (if the window is not maximized) or the button at
the left end of the menu bar (if the window is maximized).
?

In OMNIC Help Topics find “task window” in the Index and go to
“Task windows.”

How can I select a spectral region for an operation?
Use the region tool to drag across the region in the pane.

?
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In OMNIC Help Topics find “spectral region” in the Index and go to
“Region tool.”
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How can I display information about how a spectrum
was collected and processed?
Select the spectrum and then click the Information button to the left
of the title box. You can also double-click the spectrum’s title in the
title box.
?

In OMNIC Help Topics find “collection and processing
information” in the Index and go to “Collection and processing
information.”

If you want this kind of information displayed in a spectrum’s pane,
choose Display Setup from the View menu, turn on Sampling
Information and then specify the types of information you want
displayed by turning on options in the Sampling Information box.
?

In OMNIC Help Topics find “displaying, sampling information” in
the Index and go to “Displaying sampling information.”

How can I copy a spectrum and paste it into a text
document?
Select the spectrum and choose Copy from the Edit menu. This
places the spectrum on the Clipboard in the form of a Windows
metafile (this is the file format with the most flexibility for pasting
into other programs). You can then paste the spectrum into a
document by using a word processing program.
?

In OMNIC Help Topics find “copying, spectrum” in the Index and
go to “Copying items.”
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How can I get on-line Help while using the software?
The OMNIC on-line Help system lets you quickly find answers to
your questions about using the software. There are several ways to
enter the Help system:

• To see information about a particular feature in OMNIC, click
the feature using the right mouse button. A brief description of
the feature appears, and in most cases one or more buttons that
you can click to display more detailed information. Click the
Discussion button to display a complete discussion of the feature
(or the dialog box or window that contains the feature). Click the
How To button to display a step-by-step procedure for using the
feature (or the dialog box or window that contains the feature).

• You can press the F1 function key at any time to see a discussion
topic for the currently displayed or selected feature, dialog box
or window.

• If a dialog box or window contains a Help button, click it to see
information about the dialog box or window (or the command
that displayed it).

• To see the Contents of the OMNIC Help system, choose OMNIC
Help Topics from the Help menu.
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Quick Answers to Your Questions About
Using the Spectrometer
This chapter answers some common questions about using your
spectrometer. Each answer is followed by a reference telling you
where to go for more information.

Do I need to use an energy screen with my detector?
If you are using a highly sensitive detector such as a PbSe,
Si, MCT-A or InSb detector and your experiment deals with
information from a broad range of frequencies, you may wish to use
an energy screen to prevent the detector from becoming saturated or
producing a distorted signal.
Spectrometer Help Topics...
“Installing an energy screen” in “Setting up experiments”

When do I need to open the spectrometer cover?
You need to open the spectrometer cover to change sources. Also,
you need to open the cover if you are installing a spectrometer
component such as a laser.
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Warning

Do not operate the spectrometer with the main cover removed. The
cover protects you from exposure to laser light and live electrical
connections. S
If you must open the main cover for maintenance or service reasons,
always turn off the spectrometer power and unplug the power cord
first.

Important

If you have a CsI beamsplitter, protect it from the effects of water
vapor by minimizing the time that the cover is removed. S
Spectrometer Help Topics...
“Opening the main cover” in “Installing optional hardware”

When should I align the spectrometer?
Align the spectrometer in the following situations:

• The ambient temperature has changed by at least 5 Celsius
degrees (about 9 Fahrenheit degrees).

• You are about to perform a spectrometer validation with Val-Q
(or other software). This ensures that the validation is run with
the best possible interferometer and electronics settings.

• The spectrometer power was turned off for more than a few
minutes and has now been on for one hour.
Note

We recommend that you leave the power on continuously, but if you
do need to turn it off, allow the spectrometer to warm up for one
hour and then align it before collecting spectra. S

• The spectrometer has been on continuously for one week without
being aligned. We recommended aligning your spectrometer
once a week or, for optimum performance, once a day.
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• You have just installed a laser, source, beamsplitter or detector.
• The detector signal intensity has dropped significantly from its
usual level.

• You have just moved the spectrometer.
?

In OMNIC Help Topics find “aligning, spectrometer” in the Index
and go to “Aligning the spectrometer.”
“Maintenance and Service” chapter...
“Aligning the spectrometer” in “Maintaining your spectrometer”

Does my detector need to be cooled with liquid
nitrogen?
Detectors that have a dewar need to be cooled. Dewar detectors are
fairly large metal cylinders with a hole in the top. These include
MCT and InSb detectors. To determine if your detector requires
cooling, open the detector compartment cover and see if the detector
has a dewar.
If during a work session you find that the detector signal intensity is
decreasing, the dewar may need to be refilled with liquid nitrogen.
Spectrometer Help Topics...
“Cooling a detector” in “Setting up experiments”
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When should I change the desiccant (in sealed and
desiccated spectrometers only)?
If your spectrometer is in use, check the performance of the
desiccant by using the Check Desiccant button on the Diagnostic tab
of the Experiment Setup dialog box. If the check indicates that the
desiccant is no longer effective, replace it.

Spectrometer Help Topics...
“Checking and changing desiccant” in “Maintaining your
spectrometer”
If your spectrometer is in storage, check the round, blue indicator on
the desiccant holder under the beamsplitter compartment cover
monthly. Change the desiccant if the indicator has turned pink.

See “Ordering parts” in Spectrometer Help Topics to find the part
number for ordering desiccant bags. The desiccant holder under the
beamsplitter compartment cover holds one bag.

Which source should I use?
Use the source that is appropriate for the spectral range of your
experiment (determined by the ranges of the beamsplitter and
detector). Thermo Electron offers a mid-IR to far-IR source (ETC)
and a near-IR source (white light).
?

In OMNIC Help Topics find “source” in the Index and go to
“Specifying the source type.”
“Spectrometer Basics” chapter...
“Selecting the right beamsplitter and detector” in “Using
beamsplitters and detectors”
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Should I turn off the spectrometer when I’m not using
it?
We recommend that you leave the spectrometer on. This improves
the thermal stability of the system and gives you more consistent
results when you collect spectra.

How can I diagnose problems with the spectrometer?
The performance of the spectrometer is monitored while you collect
spectra. If a problem occurs, a troubleshooting message appears.
See the “Troubleshooting” book in Spectrometer Help Topics for
instructions for diagnosing spectrometer problems and ordering and
replacing parts.
Note

If you want to view the on-line videos to help you in troubleshooting
a problem, put the Spectrometers Tutorials CD in the computer. S
You can also make a more thorough check on a spectrometer
component by choosing Advanced Diagnostics from the Collect
menu. This starts the Bench Diagnostics program, which provides
information about the status of the component as well as
troubleshooting information, replacement procedures and
information about ordering replacement parts.

?

In OMNIC Help Topics find “diagnostics” in the Index and go to
“Checking bench components.”

How do I replace parts in the spectrometer?
Spectrometer Help Topics...
“Replacing parts”
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Maintenance and Service
This chapter describes maintenance and service routines that you can
perform on the spectrometer. We define maintenance as an
occasional procedure you perform to keep the spectrometer running
efficiently. We define service as a procedure to replace a failing part
in the spectrometer.
Warning

Perform only those procedures described in this chapter. If there are
other problems, contact Thermo Electron at one of the numbers
below. Outside the U.S.A. call your local sales or service
representative. Telephone numbers for all Thermo Electron
Customer Support offices are provided with your system.
Phone: 1-800-642-6538 (U.S.A.) or
+608-273-5015 (worldwide)
Fax:
+608-273-6883 (worldwide)
E-mail: techsupport.analyze@thermo.com
World Wide Web: http://www.thermo.com/spectroscopy S

See Spectrometer Help Topics for instructions for diagnosing
spectrometer problems and ordering and replacing parts.
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Running
diagnostic tests
on spectrometer
components
Note

If your system is not performing properly, you can use the
Diagnostic tab in the Experiment Setup dialog box to check the
performance of spectrometer components and determine the source
of the problem.

OMNIC continuously monitors the operation of the spectrometer
hardware and shows its status with the Bench Status indicator below
the menu bar of the OMNIC window. See “The OMNIC window” in
the “Your First Experiment” chapter for more information. S
Follow these steps to run the spectrometer diagnostic tests:
1. Make sure the main sample compartment is empty.

Remove any samples and sampling accessories (except a
transmission sample holder).

2. Choose Experiment Setup from the Collect menu or the
toolbar.

The Experiment Setup dialog box appears.

3. Click the Diagnostic tab.

The Diagnostic tab appears showing icons for the major
components of the spectrometer with a live display of the signal
from the detector.
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4. To run the diagnostic tests for a component, click that
component’s indicator icon.

A dialog box appears showing the status of the component. If the
operating values for the component are within proper limits, a
check mark appears in the Status column. If the value is outside
the acceptable range, an X appears in the Status column.

5. When you are finished viewing the information, choose OK.

Maintaining
your spectrometer

This section describes how to use the OMNIC software to align the
spectrometer and accessories and run performance tests.

View “Maintaining your spectrometer” in Spectrometer Help Topics
for instructions for other common maintenance procedures, such as
changing desiccant, cleaning the purge filter and cleaning the outside
of the spectrometer.

Aligning the spectrometer

Note
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To ensure optimum system performance (high signal intensity, low
noise and good sensitivity), you should align the spectrometer at
least once a week using the OMNIC software. See the answer to the
question “When should I align my spectrometer” in the preceding
chapter for more information.
If you have just turned on or moved the spectrometer, wait
15 minutes (one hour for best results) before you align it so that it
will have time to stabilize. S
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To align the spectrometer:
1. Remove any sample or accessory from the sample
compartment (except a transmission sample holder).

The beam path must be clear during alignment. Open the sample
compartment as briefly as possible to maintain a constant purge.

2. Choose Experiment Setup from the Collect menu or the
toolbar.

The Experiment Setup dialog box appears.

3. Make sure Sample Compartment on the Bench tab is set to
Main.
4. Set Gain on the Bench tab to 1.
Important

Do not use Autogain. S

5. Click the Align button on the Diagnostic tab.

When you click the Align button, the system begins to optimize
the detector signal for maximum energy throughput. Alignment
should take 2 to 4 minutes.
The live display of the detector signal changes as each
interferogram is collected. The positive peak and negative peak
intensities are shown next to Max and Min above the live
display. The interferogram location will be shown next to
Location (unless Single Beam is selected on the Bench tab).

6. When the alignment is finished, close the Experiment Setup
dialog box.
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Aligning an accessory

You can also align accessories that mount inside a sample
compartment. (This practice does not include Smart Accessories,
which do not require alignment.) First align the spectrometer without
the accessory installed, as described in the preceding section. Then
set Sample Compartment on the Bench tab of the Experiment Setup
dialog box according to the accessory location. Set Gain to a value
that gives a signal intensity that is appropriate for the accessory.
ATR (attenuated total reflection) and diffuse reflection accessories
typically use a Gain setting of 2 or 4.
If you are not satisfied with the signal intensity after alignment, you
can manually align most accessories to maximize the signal. For
complete instructions, see the manual that came with the accessory.
When you manually adjust an accessory, watch the largest
interferogram peak in the live display on the Bench tab. The larger
this peak, the better is the signal intensity.

Note

The largest interferogram peak can be positive or negative. S
If you are unable to see the display, turn on Tone on the Bench tab
before adjusting the accessory. The tone reaches its highest pitch
when the signal is maximized.

Checking
spectrometer
performance

132

You can use the performance test to track long-term spectrometer
performance. Run the test after you have installed the system and
then weekly. Keep a record of the actual values obtained. When you
run the test, the software measures the response of the spectrometer
optics and atmospheric absorptions inside the spectrometer and then
collects a “sample” spectrum with no sample in place. The result is a
“100% line,” a display of system noise that appears as a generally
flat line at 100% transmittance.
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Follow these steps to perform the performance test:
1. Make sure the main sample compartment is empty.

Remove any samples and sampling accessories (except a
transmission sample holder).

2. Exit OMNIC.

This ensures that the Bench Diagnostics software will run
correctly.

3. Start the Bench Diagnostics software.

To do this, click the Start button on the Windows taskbar, point
to Programs (All Programs in Windows XP), point to the
Thermo Nicolet folder and then choose Bench Diagnostics.
See “Performing advanced diagnostic tests” in the
“Troubleshooting Hardware Problems” chapter for more
information about running the diagnostics software.

4. Click the Performance Tests button and then follow the
instructions that appear on the screen.
Note

If the noise readings are greater than normal or have changed
significantly, call the Thermo Electron Technical Support for
assistance. Outside the U.S.A., call your local service representative.
Telephone numbers for all Thermo Electron offices are provided
with your system. S
If special performance tests are available for your spectrometer,
a button labeled “Extended Tests” (or another appropriate name)
will appear. Click this button and follow the instructions that
appear on the screen to perform the tests.
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Servicing your
spectrometer
Note

Some spectrometer components—including the detector, light
source, laser and power supply—were designed so you can replace
them yourself if they fail.
The diagnostics software will alert you to failing components. For
instructions for diagnosing spectrometer problems, ordering parts
and replacing parts, choose Spectrometer Help Topics from the Help
menu. S
If the source, laser module, electronics module or power supply must
be replaced, refer to the replacement parts list made available when
you choose Spectrometer Help Topics from the Help menu. Call
800-642-6538 or 608-276-6373 to order the replacement assembly.
If you are outside the U.S.A., contact your local Thermo Electron
office. Telephone numbers for all Thermo Electron Customer
Support offices are provided with your system.
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Troubleshooting Software Problems
The OMNIC software automatically and continuously checks the
status of your system. If a problem is found, a message automatically
appears giving you access to more information. This chapter lists
some simple troubleshooting measures you can take to solve
software problems with OMNIC. If the action does not solve the
problem, call your Thermo Electron service office.
?

In OMNIC Help Topics find “troubleshooting” in the Index and go
to “Troubleshooting” for more information.

Problem

Possible Cause

Solution

You cannot add a
spectrum to a user
library.

The resolution of the spectrum
is lower (higher numerical
value) than that of the library.

Collect the spectrum at the same resolution
as the library (first set Resolution on the
Bench tab of the Experiment Setup dialog
box) and then add it to the library.

The spectrum is from a
commercial library.

Only spectra you collect can be added to a
user library. Commercial libraries cannot be
altered and the spectra contained in them
cannot be copied to other libraries.

No quantitative analysis
method is selected.

Select a quantitative analysis method using
Quant Setup in the Analyze menu.

No spectrum is selected.

Select a single spectrum.

The quantitative analysis
method is not appropriate for
the selected spectrum.

Select an appropriate method for the
selected spectrum.

The Quantify
command is dimmed.
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Problem

Possible Cause

Solution

After data collection, a
message says the
sample and
background spectra
have the wrong
resolution.

The resolution of the current
background spectrum does not
match the resolution selected
for the sample spectrum
collection.

Change the Resolution to match the
background and collect the spectrum again.
Use the Resolution parameter on the Collect
tab of the Experiment Setup dialog box.

An experiment
provided with OMNIC
does not produce good
results.

The parameter settings in the
experiment file have been
changed so that the experiment
is no longer useful.

Restore the experiment to its default
settings: First open the experiment using
Experiment Setup and save it using a new
filename if you do not want to overwrite it.
Then open the experiment in the
FACTORY directory whose filename is
same as the original experiment and save it
in the OMNIC\PARAM directory.

The desired
experiment does not
appear in the
Experiment dropdown list box.

The experiment was installed
with the software but has not
yet been opened.

If the experiment was designed for a Smart
Accessory, install the accessory; the
experiment will be opened automatically
and will appear in the Experiment dropdown list box. If the experiment was not
designed for a Smart Accessory, open it
using Experiment Setup; it will be added to
the list.

Libraries created with
previous version of
OMNIC are not listed
in the Library Setup
dialog box.

The libraries are not in one of
directories listed in the dialog
box (typically LIBS within the
OMNIC directory).

Use the Add Directory button on the Search
Libraries tab to add the directory.
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Troubleshooting Hardware Problems
OMNIC continuously monitors the operation and status of your
spectrometer and informs you if a problem is found. The Bench
Status indicator below the menu bar shows the status of the
spectrometer operation. When OMNIC performs a check and detects
a problem, the Bench Status indicator is displayed as a yellow circle
or a red X along with an message alerting you to the problem.
If the indicator is a yellow circle, an MCT detector in the
spectrometer has become warm. A message appears explaining the
problem and allowing you to access information about correcting it.
If the indicator is a red X, the spectrometer has failed a diagnostic
test and requires corrective action. A message appears explaining the
problem and allowing you to access information about correcting it.
This chapter lists some simple troubleshooting measures you can
take to solve problems with the spectrometer. The Bench
Diagnostics software is described at the end of the chapter. If your
actions do not solve the problem, call Thermo Electron.
For more troubleshooting information see the “Troubleshooting”
book in Spectrometer Help Topics.
Warning

Always follow the safety precautions included in this manual and in
your Spectrometer Safety Guide when performing any of the
following troubleshooting procedures. S
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Problem

Possible Cause

Solution

Data is not displayed
during collection.

The data cable between the
spectrometer and computer is
not properly connected.

Turn the spectrometer power off and
check the data cable connections.

The spectrometer is out of
alignment.

Align the spectrometer using the
Align button on the Diagnostic tab
of the Experiment Setup dialog box.

The laser is not functioning.

Click the laser indicator on the
Diagnostic tab of the Experiment
Setup dialog box to check the laser
operation. Call Thermo Electron to
order a replacement laser if
necessary. See the “Ordering parts”
and “Servicing your spectrometer”
books in Spectrometer Help Topics
to find part number and ordering and
installation instructions.

The spectrometer is overheated.
(You can check whether the
temperature of the electronics
board is within the acceptable
range by clicking the
electronics indicator on the
Diagnostics tab of the
Experiment Setup dialog box.)

Make sure the cooling vents on the
back of the spectrometer are not
blocked. Make sure the ambient
temperature is between 16° and
27°C (60° and 80°F).
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Problem

Possible Cause

Solution

The baseline is not
stable.

The purge flow rate is too high.

Lower the flow rate until the
baseline is stable.

The spectrometer is out of
alignment.

Align the spectrometer using the
Align button on the Diagnostic tab
of the Experiment Setup dialog box.

The laser detector is
misaligned.

Use the Bench Diagnostics software
to check the laser levels for proper
balance. If the levels are out of
tolerance, align the spectrometer
using the Align button on the
Diagnostic tab of the Experiment
Setup dialog box. If the levels
remain out of tolerance, call Thermo
Electron for service.

The ambient conditions are
outside the allowed ranges.

Make sure the conditions meet the
requirements given in the
“Environmental Considerations”
chapter of Preparing Your Site.

The desiccant cannot absorb
any more water vapor.

Check the humidity indicator and
replace the desiccant and indicator if
needed.

The spectrometer cover was
recently opened.

Allow the spectrometer to purge for
3 to 5 minutes after the cover is
closed.
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Problem

Possible Cause

Solution

The status indicators on
the spectrometer cover
do not light when the
spectrometer is turned
on.

The power supply connection
on the back of the spectrometer
is loose.

Turn off the spectrometer and check
the connections between the
spectrometer and the power supply.
Make sure the lock ring is tightened
finger-tight.

The spectrometer is not plugged Make sure the power cord is
securely connected to the power
in.
supply and a working outlet or
power strip.
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The power cord is not properly
rated for your electrical service.

Make sure the power cord is
appropriate for your AC power
source. In Spectrometer Help Topics
see “Miscellaneous parts” in the
“Ordering parts” book for power
cord descriptions and part number
information.

The ground prong on the power
cord has been removed or is
defective.

Replace the power cord. In
Spectrometer Help Topics see
“Miscellaneous parts” in the
“Ordering parts” book for power
cord descriptions and part number
information.

The power cable or power
supply is defective.

Replace the power cord. If the
problem persists, replace the power
supply. In Spectrometer Help Topics
see “Changing the power supply in
the “Replacing parts” book.
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Problem

Possible Cause

Solution

System does not scan.

Laser is flickering.

Click laser indicator on Diagnostic
tab of Experiment Setup dialog box
to check laser operation. Call
Thermo Electron for assistance.

The system scans
normally but gives very
low signal intensity.

The spectrometer is out of
alignment.

Align the spectrometer using the
Align button on the Diagnostic tab
of the Experiment Setup dialog box.

The moving mirror velocity is
set too high.

Set Velocity on the Bench tab of the
Experiment Setup dialog box to a
lower velocity.

There is no interferogram.

If the Source status indicator is off,
click the source indicator on the
Diagnostic tab of the Experiment
Setup dialog box to check the source
current and voltage. If the Source
indicator is on, check the
interferogram on the Bench tab of
the Experiment Setup dialog box; if
the interferogram is not present,
check the beam path and detector.

The beam path is obstructed.

Remove the obstruction.

The aperture is set incorrectly
on a Nicolet 6700.

Check the Aperture parameter on the
Bench tab of the Experiment Setup
dialog box. For an MCT-A, MCT-B,
InSb, PbSe, Si, or InGaAs detector,
set Aperture to 32. For a DTGS
detector, set Aperture to 100.

Continued on next page...
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Problem

Possible Cause

Solution

...continued

The spectrometer is overheated.
(You can check whether the
temperature of the electronics
board is within the acceptable
range by clicking the
electronics indicator on the
Diagnostics tab of the
Experiment Setup dialog box.)

Make sure the cooling vents on the
back of the spectrometer are not
blocked. Make sure the ambient
temperature is between 16° and
27°C (60° and 80°F).

A sampling accessory is not
installed properly or is not
aligned.

Make sure the accessory is installed
correctly and, if necessary, align it.
See the instructions that came with
the accessory.

Detector and beamsplitter are
not compatible.
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Make sure that selected detector and
beamsplitter are compatible. Change
detector or beamsplitter if necessary.

Problem

Possible Cause

Solution

The signal intensity is
low. (Also, the Scan
indicator may flash
intermittently and the
spectrometer alignment
may fail.)

The source is glowing
unevenly.

Check to see if the source element is
glowing evenly. Order a
replacement source if needed.

The beam path is obstructed.

Remove the obstruction.

The sample compartment
windows are fogged.

Replace the windows. In
Spectrometer Help Topics view
“Replacing sample compartment
windows” in “Replacing parts” to
find part number, ordering and
installation instructions.

The beamsplitter is fogged.

Check the laser signals by clicking
the laser indicator on the Diagnostic
tab of the Experiment Setup dialog
box. For a Nicolet 6700, replace the
beamsplitter, if necessary. For a
Nicolet 4700, contact technical
support.

The spectrometer is out of
alignment.

A sampling accessory is not
installed properly.

A detector that was just
installed is not seated properly.

Align the spectrometer using the
Align button on the Diagnostic tab
of the Experiment Setup dialog box.
Make sure the accessory is installed
according to the instructions that
came with it.
Make sure the hole and slot in the
detector plate fit over the pins on the
spectrometer baseplate. See
“Replacing the detector” in the
“Servicing your spectrometer” book
in Spectrometer Help Topics.
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Problem

Possible Cause

Solution

The source status
indicator is off.

The source is burned out.

Click the source indicator on the
Diagnostic tab of the Experiment
Setup dialog box to verify that the
source is burned out. Call Thermo
Electron to order a replacement
source. In Spectrometer Help Topics
view “Replacing your source” in
“Replacing parts” to find part
number, ordering and installation
instructions.

There is frost on the
outside of the detector.

The insulating vacuum chamber If you suspect your detector has a
of the dewar has begun to leak. vacuum leak, view “Detector does
not stay cooled” in the
“Troubleshooting” book in
Spectrometer Help Topics.

You encounter problems
when selecting external
detectors on an AEM,
GC interface or
microscope.

A custom detector is selected
on the Bench tab of the
Experiment Setup dialog box.

Set Detector to None on the Bench
tab of the Experiment Setup dialog
box.

The detector cable is loose at
the accessory connector (on the
rear of the spectrometer or on
the back wall of the sample
compartment).

Check and tighten the cables.
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Problem

Possible Cause

Solution

The Scan status
indicator does not flash;
the system is not
scanning.

The spectrometer is turned off.

Turn on the spectrometer power.

The spectroscopy software has
not been started.

Start OMNIC (or other software you
are using).

The spectrometer is out of
alignment.

Align the spectrometer using the
Align button on the Diagnostic tab
of the Experiment Setup dialog box.

Note: After 1 hour
without data collection
activity, the
interferometer stops
scanning and the Scan
light stays on. This is
normal. Any data
collection activity will
cause the interferometer
to begin scanning.

The electronics module needs to Turn off the power to the computer
be reset.
and the spectrometer. Leave the
power off for 15 seconds. Turn on
the spectrometer and wait until the
start-up diagnostics finish. Then turn
on the computer and restart OMNIC.
The laser is flickering.

Click the laser indicator on the
Diagnostic tab of the Experiment
Setup dialog box to check the laser
operation. Call Thermo Electron for
assistance.

The laser is off.

Turn off the spectrometer power,
unplug the power cord, remove the
spectrometer cover and make sure
the laser cable is seated properly.
See “Replacing the laser” in the
“Servicing your spectrometer” book
in Spectrometer Help Topics for
instructions. Warning: Never open
the spectrometer cover without first
turning off the power and
unplugging the power cord.

Continued on next page...
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Problem

Possible Cause

Solution

The Scan status
indicator does not flash,
continued…

The laser or electronics module
is defective.

Check the laser indicator on the
Diagnostic tab of the Experiment
Setup dialog box. If there is a red
slash through the indicator, click the
indicator to view information about
the laser operation.
If the laser frequency is outside the
specified range, call Thermo
Electron to have the electronics
module replaced.
If the laser voltage or current is
outside the specified range, replace
the laser. View “Replacing the
laser” in the “Servicing your
spectrometer” book in Spectrometer
Help Topics for instructions.
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The spectrometer is overheated.
(You can check whether the
temperature of the electronics
board is within the acceptable
range by clicking the
electronics indicator on the
Diagnostics tab of the
Experiment Setup dialog box.)

Make sure the cooling vents on the
back of the spectrometer are not
blocked. Make sure the ambient
temperature is between 16° and
27°C (60° and 80°F).

A component has failed.

Call Thermo Electron for service.

The beamsplitter is not properly
seated.

For a Nicolet 6700, check the
beamsplitter and reposition it if
necessary.
For a Nicolet 4700, call Thermo
Electron for service.

Thermo Electron Corporation

Problem

Possible Cause

Solution

Laser status indicator is
off.

The beamsplitter compartment
cover is not fully closed.

Close the beamsplitter compartment
cover.

The laser is burned out.

Click the laser indicator on the
Diagnostic tab of the Experiment
Setup dialog box to verify that the
laser is burned out. Call Thermo
Electron to order a replacement
laser. View “Replacing the laser” in
the “Replacing parts” book in
Spectrometer Help Topics to find
part number and ordering and
installation instructions.

The light source is not working.

Check the source indicator on the
Diagnostic tab of the Experiment
Setup dialog box. If necessary,
replace the source.

An MCT detector is not cooled.

Check and cool the detector.

The interferogram peak is not
located at 1024 ± 16 data points
on the Bench tab of the
Experiment Setup dialog box.

Align the spectrometer. If the
interferogram is still not located
correctly, call Thermo Electron for
service.

The beam path is obstructed.

Remove the obstruction.

The data cable between the
spectrometer and the computer
is not properly connected.

Turn off the spectrometer power and
check the data cable connections.

The detector and beamsplitter
are not compatible.

Change the detector or beamsplitter.

An error message
appears when you try to
scan.
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Performing
advanced
diagnostic tests

You can use the Bench Diagnostics program to perform diagnostic
tests on the main components of the spectrometer. You should run
these tests if you have problems with your spectrometer to determine
the cause. The diagnostics provide information about the status of the
component as well as troubleshooting information, replacement
procedures and information about ordering replacement parts.
Use the diagnostics software to:

•
•
•
•
•

Run the spectrometer performance test
Test specific components of your spectrometer
Get information about replacement parts
Check the spectrometer configuration
Get troubleshooting tips

Follow these steps to run the diagnostics:
1. Make sure the main sample compartment is empty.

Remove any samples and sampling accessories (except a
transmission sample holder).

2. Start the Bench Diagnostics software.

To do this, choose Advanced Diagnostics from the Collect menu.
You can also close OMNIC, click the Start button in Windows,
point to Programs (All Programs in Windows XP), point to the
Thermo Nicolet folder and then choose Bench Diagnostics. This
gives you access to advanced features of the software, including
the performance test, that are not available if you run the
diagnostics from OMNIC.
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3. Follow the directions that appear on the screen to run the
diagnostic tests.

When you are finished viewing information in a window, you
can use the navigation buttons to return to earlier windows. Click
this button to return to the previous window:

Click this button to return to the main Diagnostics window:

To exit the Bench Diagnostics software, click the Close button at
the far right end of the title bar.
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Troubleshooting Applications Problems
If you have turned on OMNIC’s spectral quality checks feature, the
software automatically checks the status of collected interferograms,
and background and sample spectra. When OMNIC performs a
check and detects a problem with data collection or spectra, the
Collect Status indicator is displayed as a yellow circle or a red X.
You can click the indicator (or click the View Collect Status button
at the end of data collection) to see a summary of data collection
problems encountered during the collection and other information
about the collection.
This chapter lists some simple troubleshooting measures you can
take to solve data collection problems with the spectrometer. If the
action does not solve the problem, call your Thermo Electron service
office.
?

In OMNIC Help Topics find “troubleshooting” in the Index and go
to “Troubleshooting” for more information.

Problem

Possible Cause

Solution

A spectrum contains
fringes or channeling.

The sample has parallel,
highly reflective sides that
cause the infrared beam to
bounce within the sample
when it is placed
perpendicular to the beam.

Create a new film using a matte press.
Try roughening the film surface
slightly with silicon carbide paper or
other suitable abrasive.
Rotate the sample so that the infrared
beam passes through sample at
Brewster’s angle. (Do not use this
method if you are performing a
quantitative analysis of sample.)
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Problem

Possible Cause

Solution

A spectrum contains
totally absorbing peaks.

The sample in a transmission
experiment is too thick.

Use a thinner sample.

A spectrum contains
The background spectrum is
carbon dioxide peaks that too old.
interfere with your data.
The spectrometer is not
adequately purged.

A spectrum contains
water peaks that interfere
with your data.

Collect a new background spectrum to
use for ratioing your sample spectra.
Make sure you are using the correct
purge gas and that purge flow rate is
adequate. Allow the system 3 to 5
minutes to reestablish purge before
collecting the spectrum.

The spectrometer is not
purged.

Install an appropriate purge gas source
and optional purge kit. Contact
Thermo Electron for details.

The spectrometer is purged
but the air dryer does not
remove carbon dioxide.

Replace the air dryer with one that
removes carbon dioxide, or use
nitrogen to purge the spectrometer.
Contact Thermo Electron for more
information.

The desiccant cannot absorb
any more water vapor.

Check the humidity indicator and
replace the desiccant and indicator if
needed.

The spectrometer is not
adequately purged.

Make sure you are using the correct
purge gas and that purge flow rate is
adequate. Allow the system 3 to 5
minutes to reestablish purge before
collecting the spectrum.

The spectrometer is not
purged.

Install an appropriate purge gas source
and optional purge kit. Contact
Thermo Electron for details.
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Problem

Possible Cause

Solution

A spectrum contains no
peaks.

No sample is in the infrared
beam path.

Check the sample compartment or
accessory to make sure the sample is
properly positioned in the beam path.

The sampling cup in a diffuse
reflection experiment is not in
place or is tilted.

Make sure the cup is properly
positioned in the diffuse reflection
accessory. For more information, view
the appropriate tutorial available
through Sampling Techniques in the
Help menu.

An infrared microscope is in
its viewing mode.

Put the microscope in infrared mode
and collect the spectrum again.

A sample film in an ATR
experiment is being held
against the ATR crystal with
uneven pressure or has poor
contact with the crystal.

Make sure the sample is held evenly
and has good contact with the crystal.

The resolution is set too low.

Set Resolution on the Collect tab of
the Experiment Setup dialog box to a
value that lets you see small peaks.
(Use a lower numerical setting to
achieve higher resolution.)

A sample in a diffuse
reflection experiment also has
a specular reflection
component.

Correct the spectrum by using Other
Corrections in the Process menu.
(Select Kramers-Kronig.)

The infrared beam was
reflected from (instead of
penetrating) a flat, shiny
sample measured using a
specular reflection accessory.

Try using a less reflective sample.

A spectrum contains
derivative-shaped peaks.
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Problem

Possible Cause

Solution

The baseline of the
spectrum is not flat.

The KBr pellet was made with
coarsely ground KBr powder,
or the KBr pellet was
improperly pressed.

Be sure to press the pellet properly.

The background spectrum for
a cast film was collected with
an empty sample holder in the
infrared beam.

Remove the sample holder and collect
the background again.

The spectrometer is not
properly aligned, causing a
sloped baseline.

Use the Align button on the
Diagnostic tab of the Experiment
Setup dialog box to align the
spectrometer.

The spectrometer has not been
on long enough to reach
thermal equilibrium.

For best results allow the spectrometer
at least one hour to stabilize after
turning it on.

The spectrometer is not
properly purged.

Check the system to make sure the
correct purge gas is being used and
that the flow rate is correct.
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Problem

Possible Cause

Solution

A spectrum is too noisy.

There were too few scans.

Increase the number of scans on the
Collect tab of the Experiment Setup
dialog box.

The resolution was too high.

Reduce the resolution (use a higher
numerical setting) on the Collect tab
of the Experiment Setup dialog box.

The purge gas flow rate or
pressure is too high.

Check the pressure regulator; it should
be set between 0.7 and 1.4 bar (70 and
140 kPa, or 10 and 20 psig). Check the
flowmeter; it should read 15 scfh
(about 0.4 m3/hr). Adjust the flow rate
if necessary.

The detector is saturated.

Add a bandwidth-limiting filter or an
energy screen to reduce the signal
strength.

The moving mirror velocity is
set too high for the detector.

Set Velocity on the Bench tab of the
Experiment Setup dialog box to a
lower value.

The sample in an ATR
experiment is not in good
contact with the ATR crystal.

Reapply the sample to obtain more
consistent contact between the sample
and the ATR crystal.
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Index
a

b

absolute transmission accessory................................... 85
absorbance units ........................................................... 38
accessories.................................................................... 81
aligning ............................................................... 132
automated sample handling................................... 85
available ................................................................ 12
cabling................................................................... 91
descriptions ........................................................... 85
detector.................................................................. 92
installing...................................................... 6, 12, 85
not aligned........................................................... 142
not installed correctly.................................. 142, 143
power..................................................................... 92
system ................................................................... 90
when to turn on ............................................... 18, 56
Advanced Diagnostics........................................ 127, 148
AEM............................................................................. 86
air dryer ................................................................ 90, 151
aligning
accessory ............................................................. 132
spectrometer ................................................ 124, 130
annotation tool............................................................ 120
aperture....................................................................... 141
effect on resolution................................................ 67
effect on wavenumber accuracy............................ 67
for collecting data in visible spectral range........... 70
incorrect .............................................................. 141
resolution affected by............................................ 70
size for cooled detector ......................................... 67
size for detector..................................................... 67
ATR accessory ........................................... 81, 82, 83, 84
ATR correction........................................................... 103
ATR sample contact ................................................... 154
Auxiliary 1 connector................................................... 93
Auxiliary 2 connector................................................... 93
Auxiliary connector...................................................... 92
auxiliary experiment module........................................ 86

Background button........................................................53
background spectrum
collected with sample holder in beam..................153
collecting .........................................................32, 53
defined ...................................................................27
too old ..................................................................151
when to collect.......................................................27
bandwidth-limiting filter...............................................65
baseline
correcting .....................................................102, 116
not flat..................................................................153
not stable..............................................................139
sloped...................................................................153
baseplate
custom....................................................................86
removing................................................................85
baseplates
Smart......................................................................28
Snap-In...................................................................28
beam path
blocked.................................................141, 143, 147
beamsplitter
changing.................................................................10
compatibility with detector ....................................60
fogged ..................................................................143
not compatible with detector........................142, 147
not properly seated...............................................146
spectral range .........................................................62
types.......................................................................60
which to use ...........................................................11
beamsplitter compartment cover.................................147
Bench Diagnostics ......................................127, 129, 148
Bench Status indicator ..................................................26
blanking totally absorbing bands ................................102
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c
cable not connected properly.............. 138, 140, 144, 147
cabling accessory.......................................................... 91
carbon dioxide
removing peaks due to......................................... 103
channeling in spectrum............................................... 150
cleaning purge filter.................................................... 130
closing window........................................................... 120
Collect Sample window................................................ 99
Collect Status indicator......................................... 37, 150
collecting
background ............................................................ 53
background spectrum ............................................ 32
sample spectrum ........................................ 27, 30, 53
spectrum .................................. 12, 14, 23, 27, 30, 98
color of spectrum........................................................ 111
commercial library
finding compound in ........................................... 105
common scale ............................................................. 112
components
separating with subtraction.................................. 117
computer
saving spectra on hard disk ................................. 107
when to turn on................................................ 19, 56
configuration
default.................................................................... 30
opening .................................................................. 30
saving .................................................................. 119
connector
Auxiliary 1............................................................. 93
Auxiliary 2............................................................. 93
detector .................................................................. 92
Detector/Motors..................................................... 95
pass-through .......................................................... 91
connectors
Auxiliary pinouts................................................... 94
for custom accessories........................................... 94
pass-through .......................................................... 94
sample compartment.............................................. 92
contaminants
identifying with subtraction................................. 117
cooled detector
aperture size for ..................................................... 67
cooling detector .................................................... 19, 125
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copying spectrum ....................................................... 121
correcting
baseline ....................................................... 102, 116
spectrum.............................................................. 102
custom accessories ....................................................... 94
cuvette .......................................................................... 87

d
data collection .......................................................... 9, 14
default configuration .................................................... 30
default experiment........................................................ 30
deleting
report notebook ................................................... 109
spectrum.............................................................. 108
depth of penetration ................................................... 103
desiccant............................................................. 139, 151
changing.............................................................. 130
checking ................................................................ 17
when to change ................................................... 126
desiccant indicator................................................ 17, 126
detector
accessory ............................................................... 92
aperture size for..................................................... 67
cable .................................................................... 144
changing................................................................ 11
compatibility with beamsplitter............................. 60
connector............................................................... 92
cooling .......................................................... 19, 125
custom ................................................................. 144
energy screen ............................ 66, 69, 70, 123, 154
external................................................................ 144
frosted ................................................................. 144
linearity ................................................................. 64
not compatible with beamsplitter ................ 142, 147
not cooled............................................................ 147
not installed properly .......................................... 143
photometric accuracy ............................................ 65
saturated ...................................... 64, 65, 66, 67, 154
saturation............................................................. 123
signal intensity .................................................... 131
silicon.................................................................... 70
spectral range ........................................................ 62
types ...................................................................... 60
using filter to reduce energy reaching................... 64

detector, continued…
velocity too high for............................................ 154
which to use .......................................................... 11
detector interface kit..................................................... 86
Detector/Motors connector........................................... 95
dewar
leaking................................................................. 144
diagnostics.......................................................... 129, 148
diffuse reflection accessory.................................... 81, 82
directory
library.................................................................. 136
dispersion effects........................................................ 103
Display Setup ............................................................. 111
distortion in spectrum................................................... 69
documentation ................................................................ 6
dual sources option....................................................... 58

e
electronics module ..................................................... 145
defective .............................................................. 146
replacing.............................................................. 134
e-mail.......................................................................... 3, 7
energy screen.................................................. 66, 69, 154
detectors typically used with................................. 66
energy passed with ................................................ 66
for collecting data in visible spectral range........... 70
optional wheel ....................................................... 86
resolution affected by............................................ 70
when to use ......................................................... 123
energy screen wheel ..................................................... 75
error message during data collection.......................... 147
Expand/Contract button ............................................. 113
experiment
default ................................................................... 30
not listed.............................................................. 136
restoring .............................................................. 136
selecting .................................................... 21, 25, 30
Experiment drop-down list box.................. 21, 25, 30, 97
Experiment Setup ................................................... 21, 25
extended search feature .............................................. 105
external detector ......................................................... 144
external source ............................................................. 59

f
fax number ..................................................................3, 7
fiber optic accessory ...............................................83, 88
filename for saving spectrum........................................37
filter
bandwidth-limiting ................................................65
for collecting data in visible spectral range ...........70
installing in sample holder.....................................29
reducing energy reaching detector using ...............64
filter wheel ..............................................................72, 86
finding peaks...............................................................120
flammable gases............................................................15
flowmeter ......................................................................15
Foundation Series .........................................................87
fringes in spectrum......................................................150
frost on detector ..........................................................144
FT-IR ..............................................................................6
full scale......................................................................112

g
gain ...............................................................................99
for collecting data in visible spectral range ...........70
gas cells.........................................................................87
GC interface..................................................................87
Getting Started tutorial....................................................1
grazing angle accessory ................................................84

h
hardware requirements....................................................4
Help.....................................................................6, 7, 122

i
Information button ......................................................121
infrared source ..............................................................58
InSb detector ...............................................................125
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installing
accessories ......................................................... 6, 12
accessory ............................................................... 85
beamsplitter ........................................................... 10
detector .................................................................. 11
hardware .................................................................. 7
OMNIC.................................................................... 5
optical filter ........................................................... 29
sample........................................................ 11, 29, 34
sample holder ........................................................ 28
source .................................................................... 11
interferogram
location ................................................................ 147
not present ........................................................... 141
saving .................................................................... 99
interferometer
stand-by mode ..................................................... 145
IUPAC .......................................................................... 64

k
KBr pellet improperly pressed.................................... 153
Kramers-Kronig correction ................................ 103, 152
Kubelka-Munk units................................................... 101

l
labeling peak............................................................... 120
laser
burned out............................................................ 147
defective .............................................................. 146
detector misaligned.............................................. 139
flickering ..................................................... 141, 145
indicator................................................................. 18
not on................................................................... 145
not working ......................................................... 138
replacing .............................................................. 134
Laser indicator .............................................................. 56
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library
adding spectrum to........................................ 47, 105
commercial.......................................................... 105
comparing sample spectrum with spectra in ......... 43
creating...................................................... 7, 47, 104
directory .............................................................. 136
not listed.............................................................. 136
saving spectra in.................................................. 107
scrapbook ............................................................ 104
searching ............................................................. 102
spectrum cannot be added to............................... 135
library search
extended search feature....................................... 105
search expert ....................................................... 106
specifying spectral regions for ............................ 103
library spectrum
displaying............................................................ 104
linearity ........................................................................ 64
Liquid Analysis System ............................................... 87
liquid nitrogen for cooling detectors .......................... 125
log (1/R) units ............................................................ 101

m
macro............................................................................ 53
Macro button ................................................................ 53
maintenance ................................................. 13, 128, 130
matched scale ............................................................. 112
math
subtracting........................................................... 116
when to use subtraction....................................... 117
math operations .......................................................... 118
MCT detector ............................................................. 125
menu bar....................................................................... 25
menu names.................................................................. 25
microplate accessory .................................................... 87
microscope
descriptions ........................................................... 88
in viewing mode.................................................. 152

mirror velocity.............................................................. 71
moving
spectrum in pane ................................................. 114
spectrum to another window ............................... 114
stacked spectrum ................................................. 114
moving mirror
velocity limitations................................................ 71

n
Nicolet Centaurµs......................................................... 88
Nicolet Continuµm ....................................................... 88
noise ....................................................................... 65, 69
number of scans
signal-to-noise ratio affected by............................ 69
too low ................................................................ 154

o
offset scale.................................................................. 112
OK/Enter button ........................................................... 53
OMNIC
customizing ......................................................... 119
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